VMware vCenter Converter Installation and Administration Guide

vCenter Converter 4.2

This document supports the version of each product listed and supports all subsequent versions until the document is replaced by a new edition. To check for more recent editions of this document, see http://www.vmware.com/support/pubs.
You can find the most up-to-date technical documentation on the VMware Web site at:
http://www.vmware.com/support/
The VMware Web site also provides the latest product updates.
If you have comments about this documentation, submit your feedback to:
docfeedback@vmware.com
Select a Virtual Machine to Export  60
Select a Destination for the New Virtual Machine  61
Configure the Hardware of the Destination Virtual Machine  63
Configure the Software of the Destination Virtual Machine  69
Configure the Export Task  74
Schedule the Export Task  75
Review the Summary and Submit the Export Task  76

6 Reconfigure vCenter Server Machines  77
   Save Sysprep Files  78
   Start the Reconfigure Virtual Machine Wizard  78
   View Details About the Source Virtual Machine  78
   Select the Options to Reconfigure  79
   Review and Submit the Reconfiguration Task  83

7 Managing vCenter Converter Tasks  85
   Displaying and Monitoring vCenter Converter Tasks  85
   Managing Scheduled Import and Export Tasks  87
   Collecting vCenter Converter Log Files  89

Index  93
About This Book

The vCenter Converter Installation and Administration Guide provides information about installing and using VMware® vCenter Converter for VMware vCenter Server 4.1.

Intended Audience

This book is intended for users who want to do the following:

- Install, upgrade, or use vCenter Converter
- Nonintrusively copy and transform physical machines into VMware virtual machines that VMware vCenter manages

The material in this book is written for information systems engineers, software developers, QA engineers, trainers, salespeople who run demonstrations, and anyone who wants to create virtual machines.

VMware Technical Publications Glossary

VMware Technical Publications provides a glossary of terms that might be unfamiliar to you. For definitions of terms as they are used in VMware technical documentation, go to http://www.vmware.com/support/pubs.

Document Feedback

VMware welcomes your suggestions for improving our documentation. If you have comments, send your feedback to docfeedback@vmware.com.
Technical Support and Education Resources

The following technical support resources are available to you. To access the current version of this book and other books, go to http://www.vmware.com/support/pubs.

**Online and Telephone Support**

To use online support to submit technical support requests, view your product and contract information, and register your products, go to http://www.vmware.com/support.

Customers with appropriate support contracts should use telephone support for the fastest response on priority 1 issues. Go to http://www.vmware.com/support/phone_support.html.

**Support Offerings**

To find out how VMware support offerings can help meet your business needs, go to http://www.vmware.com/support/services.

**VMware Professional Services**

VMware Education Services courses offer extensive hands-on labs, case study examples, and course materials designed to be used as on-the-job reference tools. Courses are available onsite, in the classroom, and live online. For onsite pilot programs and implementation best practices, VMware Consulting Services provides offerings to help you assess, plan, build, and manage your virtual environment. To access information about education classes, certification programs, and consulting services, go to http://www.vmware.com/services.
VMware® vCenter Converter is an optional module for VMware vCenter Server. You can use vCenter Converter to import and export machines to and from your vCenter Server environment. You can also reconfigure existing virtual machines in your vCenter Server environment.

VMware vCenter Converter for vCenter Server 4.1 eases interoperability between vCenter Server and other VMware products.

- VMware hosted products can be both import sources and export destinations.
  - VMware Workstation
  - VMware Fusion™
  - VMware Server
  - VMware Player
- Virtual machines running on an ESX instance that vCenter Server manages can be both import sources and export destinations.
- Virtual machines running on nonmanaged ESX hosts can be both import sources and export destinations.

This chapter includes the following topics:

- “Migration with vCenter Converter,” on page 8
- “VMware vCenter Converter Components,” on page 8
- “Cloning and System Reconfiguration of Physical Machines,” on page 9
- “Data Cloning Modes,” on page 14
- “Converting Existing Virtual Machines and System Images,” on page 15
- “Scheduling Conversion Tasks,” on page 16
- “System Settings Affected by Conversion,” on page 16
- “Changes to Virtual Hardware,” on page 16
Migration with vCenter Converter

Migration with vCenter Converter involves importing physical machines, virtual machines, and system images, as well as exporting virtual machines for use in VMware hosted and managed products.

You can export virtual machines that vCenter Server manages for use in other VMware products. You can use vCenter Converter to perform a number of import and export tasks.

- Import running remote physical and virtual machines as virtual machines to standalone ESX/ESXi or ESX/ESXi hosts that vCenter Server manages.
- Import virtual machines such as VMware Workstation or Microsoft Hyper-V Server to ESX/ESXi hosts that vCenter Server manages.
- Import third-party backup or disk images to ESX/ESXi hosts that vCenter Server manages.
- Export virtual machines managed by vCenter Server hosts to other VMware virtual machine formats.
- Reconfigure virtual machines managed by vCenter Server so that they are bootable, and to install VMware Tools or customize their guest operating systems.
- Customize the guest operating systems of virtual machines in the vCenter Server inventory (for example, change the host name or network settings).
- Reduce the time needed to set up new virtual machine environments.
- Migrate legacy servers to new hardware without reinstalling operating systems or application software.
- Perform migrations across heterogeneous hardware.
- Readjust volume sizes and place volumes on separate virtual disks.
- Migrate disks across independent datastores.
- View audit trails.

VMware vCenter Converter Components

The vCenter Converter 4.2 application consists of vCenter Converter server, vCenter Converter worker, vCenter Converter client, and vCenter Converter agent.

**vCenter Converter server**

Enables and performs the import and export of virtual machines. The vCenter Converter server comprises two services, vCenter Converter server and vCenter Converter worker. The vCenter Converter server service must be installed together with the vCenter Converter worker service either on the vCenter Server machine or on an independent machine with access to the vCenter Server machine.

**vCenter Converter agent**

The vCenter Converter server installs the agent on Windows physical machines to import them as virtual machines. You can choose to remove the vCenter Converter agent from the physical machine automatically or manually after the import is complete.
vCenter Converter client

The vCenter Converter server works with the vCenter Converter client. The client component consists of the vCenter Converter client plug-in, which provides access to the vCenter Converter Import, Export, and Reconfigure wizards from within a vSphere Client.

**NOTE** If you open more than one vCenter Converter wizards, you can work only with the wizard you opened last. For example, if you open the Import Machine wizard followed by the Reconfigure Virtual Machine wizard, you can navigate only the Reconfigure Virtual Machine wizard.

After you install the vCenter Converter client plug-in from the vSphere Client Plug-ins menu, the vCenter Converter Online Help is available from the vSphere Client Help menu.

VMware vCenter Converter Boot CD

The VMware vCenter Converter Boot CD is a separate component that you can use to perform cold cloning on a physical machine. vCenter Converter 4.2 does not provide a Boot CD, but you can use previous versions of the Boot CD to perform cold cloning. See “Prepare for Cold Cloning,” on page 14.

Cloning and System Reconfiguration of Physical Machines

When you import a physical system, vCenter Converter uses cloning and system reconfiguration steps to create and reconfigure the virtual machine so that it works successfully in the vCenter Server environment. Because the migration process is nondestructive to the source, you can continue to use the original source machine after the import completes.

Cloning is the process of copying the source physical disks or volumes for the destination virtual machine. Cloning involves copying the data on the source machine’s hard disk and transferring that data to a destination virtual disk. The destination virtual disk could have a different geometry, size, file layout, and other, so the destination virtual disk might not be an exact copy of the source disk.

System reconfiguration adjusts the migrated operating system to enable it to function on virtual hardware.

If you plan to run an imported virtual machine on the same network as the source physical machine, you must modify the network name and IP address on one of the machines, so that the physical and virtual machines can coexist. Besides, you must make sure that the Windows source machine and the destination virtual machine have different computer names.

**NOTE** You cannot move original equipment manufacturer (OEM) licenses between physical machines. The license is attached to the server when you purchase it from the OEM and cannot be reassigned. You can only reassign retail and volume licenses to new physical servers. If you migrate an OEM Windows image, you must have a Windows Server Enterprise or Datacenter Edition license to run multiple virtual machines.

Hot and Cold Cloning of Physical Machines

Although vCenter Converter 4.2 supports only hot cloning, you can still perform cold cloning using the VMware Converter 4.1.x Boot CD. Depending on your virtual environment, you might choose to use hot or cold cloning.

Hot cloning, also called live cloning or online cloning, entails cloning the source machine while it is running its operating system. Hot cloning lets you clone machines without shutting them down.

Because processes continue to run on the source machine during the conversion, the resulting virtual machine is not an exact copy of the source machine.
You can set vCenter Converter to synchronize the destination virtual machine with the source machine after hot cloning. Synchronization is performed by transferring from the source to the destination the blocks that were changed during the initial cloning period. To avoid loss of data on the destination virtual machine, vCenter Converter can shut down certain Windows services before the synchronization. Based on your settings, vCenter Converter shuts down the selected Windows services so that no critical changes occur on the source machine while destination is being synchronized.

vCenter Converter can shut down the source machine and power on the destination machine when the conversion process is complete. When combined with synchronization, this action allows seamless migration of a physical machine source to a virtual machine destination. The destination machine takes over the source machine operations with the least possible downtime.

Cold cloning, also called offline cloning, entails cloning the source machine when it is not running its operating system. When you cold clone a machine, you reboot the source machine using a CD that has the operating system and vCenter Converter application on it. Cold cloning allows you to create the most consistent copy of the source machine because nothing changes on the source machine during the conversion. Cold cloning leaves no footprint on the source machine, but requires you to have physical access to the source machine that is being cloned.

Table 1-1 compares the hot and cold cloning modes.

### Table 1-1. Hot and Cold Cloning Comparison

<table>
<thead>
<tr>
<th>Comparison Criteria</th>
<th>Hot Cloning with vCenter Converter 4.2</th>
<th>Cold Cloning with Converter Enterprise 4.1.x</th>
</tr>
</thead>
<tbody>
<tr>
<td>Licensing</td>
<td>No license required with VMware vCenter Converter 4.2.</td>
<td>License file required for Enterprise features of VMware Converter Enterprise.</td>
</tr>
<tr>
<td>Required installation</td>
<td>Full vCenter Converter installation is required. As part of the cloning process, vCenter Converter agent is installed on the source machine remotely.</td>
<td>No installation is required. All components required for the conversion are on the CD.</td>
</tr>
<tr>
<td>Supported sources</td>
<td>Local and remote powered-on physical or virtual machines.</td>
<td>Local powered-off physical or virtual machines.</td>
</tr>
</tbody>
</table>
| Advantages          | ▪ Does not require direct access to the source machine.  
▪ You can clone the source machine while it is running. | ▪ Creates the most consistent copy of the source machine.  
▪ Leaves no footprint on the source machine. |
| Disadvantages       | ▪ Applications that constantly modify files need to be VSS aware to allow vCenter Converter to create a consistent snapshot for cloning.  
▪ Dynamic source disks are read but not preserved during volume-based conversions. Dynamic disks are converted into basic volumes on the target virtual machine. | ▪ You must restart the source machine to clone it.  
▪ Requires physical access to the source machine.  
▪ Hardware detection and configuration of Boot CD.  
▪ vCenter Converter 4.2 features are not supported. |
Table 1-1. Hot and Cold Cloning Comparison (Continued)

<table>
<thead>
<tr>
<th>Comparison Criteria</th>
<th>Hot Cloning with vCenter Converter 4.2</th>
<th>Cold Cloning with Converter Enterprise 4.1.x</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use</td>
<td>To clone running source machines without shutting them down.</td>
<td>To clone a system that Converter Standalone does not support.</td>
</tr>
<tr>
<td></td>
<td>To clone unique hardware that the boot CD does not recognize.</td>
<td>To preserve the exact disk layout in the target.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To preserve logical volumes in dynamic disks (Windows) or LVM (Linux).</td>
</tr>
<tr>
<td>Do not use</td>
<td>When you do not want anything to be installed on the source system.</td>
<td>When you want Linux P2V with automatic reconfiguration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When you do not have physical access to the source machine.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When you cannot afford a long downtime of the source system.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To perform synchronization after cloning.</td>
</tr>
</tbody>
</table>

Hot Cloning of Physical Machines

vCenter Converter 4.2 supports only hot cloning of physical machines. You can use older versions of VMware Converter for cold cloning.

You can select which services to keep running on the source machine while the conversion is running. To ensure that the destination virtual machine retains all of the blocks that changed in the source system during the initial cloning process, turn on the synchronization feature. With synchronization on, if any changes occur on the source machine during the initial conversion, vCenter Converter copies them to the destination machine after the initial conversion is complete. This process helps you to prevent downtime of important Windows services.

**Note** When you hot clone dual-boot systems, you can clone only the default operating system to which the boot.ini file points. To clone the nondefault operating system, change the boot.ini file to point to the other operating system and reboot. After the other operating system is booted, you can hot clone it. If your second operating system is Linux, you can boot it and clone it using the standard procedure for cloning Linux physical machine sources.

Remote Hot Cloning of Physical Machine Sources That Are Running Windows

You use the vCenter Converter wizards to set up conversion tasks and vCenter Converter components perform all of the cloning tasks.

The following workflow is an example of remote hot cloning in which the physical machine being cloned experiences no downtime.

1 vCenter Converter prepares the source machine for the conversion.

   vCenter Converter installs the agent on the source machine and the agent takes a snapshot of the source volumes.
2 vCenter Converter prepares the virtual machine on the destination machine.  
vCenter Converter creates a virtual machine on the destination machine and the agent copies volumes from the source machine to the destination machine.

3 vCenter Converter completes the conversion process.  
The agent installs the required drivers to allow the operating system to boot in a virtual machine and personalizes the virtual machine (changes the IP information, for example).

4 Optionally, vCenter Converter uninstalls the agent from the source machine.  
The virtual machine is ready to run on the destination server.
Remote Hot Cloning of Physical Machine Sources That Are Running Linux

The conversion process of physical machines that are running Linux operating systems differs from that of Windows machines.

In Windows conversions, the vCenter Converter agent is deployed to the source machine and the source information is pushed to the destination.

In Linux conversions, no agent is deployed on the source machine. Instead, a helper virtual machine is created and deployed on the destination ESX/ESXi host. The source data is then copied from the source Linux machine to the helper virtual machine. After the conversion is complete, the helper virtual machine shuts down to become the destination virtual machine the next time you power it on.

vCenter Converter supports conversion of Linux sources only to managed destinations.

The following workflow demonstrates the principles of hot cloning physical machine sources that run Linux to managed destinations.

1. vCenter Converter uses SSH to connect to the source machine and retrieves source information.
   vCenter Converter creates an empty helper virtual machine based on your conversion task settings. The helper virtual machine serves as a container for the new virtual machine during conversion.
   vCenter Converter deploys the helper virtual machine on the managed destination, an ESX/ESXi host. The helper virtual machine boots from a *.iso file that is located on the vCenter Converter server machine.

2. The helper virtual machine powers on, boots from the Linux image, connects to the source machine through SSH, and starts retrieving the selected data from the source. While you set up the conversion task, you can select which source volumes to be copied to the destination machine.
3 Optionally, when data copying is complete, the destination virtual machine is reconfigured to allow the operating system to boot in a virtual machine.

4 vCenter Converter shuts down the helper virtual machine. The conversion process is complete.

   Optionally, you can configure vCenter Converter to power on the newly created virtual machine after the conversion is complete.

**Cold Cloning of Physical Machines**

vCenter Converter 4.2 does not support cold cloning. You can use the Boot CD of an earlier vCenter Converter version to perform cold cloning.

When you cold clone a machine, you reboot the source machine from a CD that has its own operating system and also includes the vCenter Converter application. You can find a detailed description of the cold cloning process in the documentation of the Boot CD you select to use.

**Prepare for Cold Cloning**

Because vCenter Converter 4.2 does not support cold cloning, you must use the Boot CD of an earlier vCenter Converter edition. The features supported on the Boot CD depend on the product version you choose.

VMware vCenter Converter 4.1.x edition is not a free software product.

**Procedure**

1. To obtain a Boot CD, go to the VMware Download Web site and download vCenter Converter 4.1.x installation.
2. Extract the Boot CD .iso file from the installation package.
3. Write the Boot CD .iso file on a CD.

**What to do next**

Follow the onscreen instructions to proceed with cold cloning.

**Data Cloning Modes**

vCenter Converter supports two data cloning modes, disk-based cloning and volume-based cloning.

**Table 1-2. Cloning Modes**

<table>
<thead>
<tr>
<th>Cloning Mode</th>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume based</td>
<td>Copy volumes from the source machine to the destination machine.</td>
<td>Volume-based cloning is relatively slow. File-level cloning is slower than block-level cloning. Dynamic disks are converted into basic volumes on the target virtual machine.</td>
</tr>
<tr>
<td>Disk based</td>
<td>Create copies of the source machines, for all types of basic and dynamic disks.</td>
<td>You cannot select which data to copy. Disk-based cloning is faster than volume-based cloning.</td>
</tr>
</tbody>
</table>

**Volume-Based Cloning**

During volume-based cloning, volumes from the source machine are copied to the destination machine. vCenter Converter supports volume-based cloning for hot and cold cloning, and during the import of existing virtual machines.

In volume-based cloning, all volumes in the destination virtual machine are converted to basic volumes, regardless of their type in the corresponding source volume.
Volume-based cloning is performed at the file level or block level, depending on the destination volume size that you select.

**Volume-based cloning at the file level**
- Performed when you select a size smaller than the original volume for NTFS volumes or you select to resize a FAT volume.
- Volume-based cloning at the file level is supported only for FAT, FAT32, NTFS, ext2, ext3, and ReiserFS file systems.

**Volume-based cloning at the block level**
- Performed when you select to preserve the size of the source volume or when you select a larger volume size for NTFS source volumes.

Depending on the cloning mode, vCenter Converter might not support some types of source volumes. Table 1-3 shows the supported and unsupported source volume types.

<table>
<thead>
<tr>
<th>Cloning Mode</th>
<th>Supported Source Volumes</th>
<th>Not Supported Source Volumes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual machine import</td>
<td>- Basic volumes</td>
<td>- RAID</td>
</tr>
<tr>
<td></td>
<td>- All types of dynamic volumes</td>
<td>- Windows NT4 fault-tolerant volumes</td>
</tr>
<tr>
<td></td>
<td>- Master boot record (MBR) disks</td>
<td>- Windows NT4 mirrored volumes</td>
</tr>
<tr>
<td></td>
<td>- Windows NT4 fault-tolerant volumes</td>
<td>- GUID partition table (GPT) disks</td>
</tr>
<tr>
<td>Hot cloning</td>
<td>All types of source volumes that Windows recognizes</td>
<td></td>
</tr>
</tbody>
</table>

Dynamic source disks are read but not preserved during volume-based conversions. Dynamic disks are converted into basic volumes on the target virtual machine.

**Disk-Based Cloning**

vCenter Converter supports disk-based cloning to import existing virtual machines.

Disk-based cloning transfers all sectors from all disks and preserves all volume metadata. The destination virtual machine receives the same partitions, of the same type, as the partitions of the source virtual machine. All volumes on the source machine’s partitions are copied as they are.

Disk-based cloning supports all types of basic and dynamic disks.

**Converting Existing Virtual Machines and System Images**

You can convert virtual machines between hosted products and managed products. You can also use vCenter Converter to reconfigure virtual machines.

**Converting virtual machines**
- You can convert VMware virtual machines from and to Workstation, VMware Player, VMware ACE, VMware Fusion, ESX, ESXi Embedded, ESXi Installable, and VMware Server. You can also import virtual machines from Microsoft Virtual Server and Virtual PC.
- To run an imported VMware virtual machine and its source virtual machine on the same network, you must modify the network name and IP address on one of the virtual machines. Modifying the network name and IP address allows the original and new virtual machines to coexist on the same network.

**Configuring virtual machines**
- For VMware virtual machines with disks set up by restoration from a backup of a physical host or by some other direct means of copying, vCenter Converter prepares the image to run on VMware virtual hardware. If you used a third-party virtualization software to create a virtual machine on an ESX host, you...
can use vCenter Converter to reconfigure it. You can also reconfigure any operating system installed on a multiboot machine if you imported the virtual machine to an ESX host. Before you reconfigure a multiboot machine, you must change the `boot.ini` file.

If the VMware virtual machines have disks that are populated by using a backup of a physical host or by cold cloning, vCenter Converter prepares the image to run on VMware virtual hardware.

Whenever you use one of the vCenter Converter wizards to import, export, or reconfigure a virtual machine, you create a task. You can schedule import and export tasks. You cannot schedule reconfiguration tasks.

**Scheduling Conversion Tasks**

You can select the time when an import or export task should start. You can schedule an unlimited number of import and export tasks, as long as you do not use the same source for parallel conversion tasks.

To create scheduled tasks, you must open the Import Machine or the Export Virtual Machine wizard from the Scheduled Tasks menu item in the vSphere Client Inventory menu.

**System Settings Affected by Conversion**

A VMware virtual machine that vCenter Converter creates contains a copy of the disk state of the source physical machine, virtual machine, or system image. Some hardware-dependent drivers and sometimes the mapped drive letters might not be preserved.

The following source computer settings remain unchanged:

- Operating system configuration (computer name, security ID, user accounts, profiles, preferences, and so on)
- Applications and data files
- Volume serial number for each disk partition

Because the target and the source virtual machines or system images have the same identities (name, SID, and so on), running them on the same network might result in conflicts. To redeploy the source virtual machine or system image, make sure that you do not run the source and target images or virtual machines on the same network at the same time.

For example, if you use vCenter Converter to test whether you can run a Virtual PC virtual machine as a VMware virtual machine without first decommissioning the original Virtual PC machine, you must first resolve the duplicate ID problem. You can resolve this problem by customizing the virtual machines in the Import Machine, Export Virtual Machine, or Reconfigure Virtual Machine wizards.

**Changes to Virtual Hardware**

Most applications function correctly on the VMware virtual machine because their configuration and data files have the same location as on the source virtual machine. However, applications might not work if they depend on specific characteristics of the underlying hardware, such as the serial number or the device manufacturer.

The following table describes hardware changes that might occur after virtual machine migration.

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU model and serial numbers</td>
<td>Can be different if they are activated. They correspond to the physical computer hosting the VMware virtual machine.</td>
</tr>
<tr>
<td>Ethernet adapters</td>
<td>Can be different (AMD PCNet or VMXnet) with a different MAC address. The IP address of each interface must be individually reconfigured.</td>
</tr>
<tr>
<td>Graphics cards</td>
<td>Can be different (VMware SVGA card).</td>
</tr>
<tr>
<td>Hardware</td>
<td>Behavior</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Disks and partitions</td>
<td>The number of disks and partitions might change if you rearrange volumes during the cloning. Each disk device might have a different model and different manufacturer strings.</td>
</tr>
<tr>
<td>Primary disk controllers</td>
<td>Can be different from the source machine.</td>
</tr>
<tr>
<td>Applications</td>
<td>Might not work if they depend on devices that are not available within a virtual machine.</td>
</tr>
</tbody>
</table>
System Requirements and Limitations

You must fulfill certain requirements before you operate vCenter Converter. You must also consider the compatibilities and the interoperabilities among the systems on which and with which the vCenter Converter components work.

This chapter includes the following topics:
- “Supported Operating Systems,” on page 19
- “Installation Space Requirements,” on page 20
- “Supported Source Types,” on page 21
- “Supported Destination Types,” on page 23
- “Configuring Permissions for VirtualCenter Users,” on page 24
- “Support for IPv6 in vCenter Converter,” on page 24
- “TCP/IP and UDP Port Requirements for Conversion,” on page 25
- “Requirements for Remote Hot Cloning of Windows Operating Systems,” on page 26

Supported Operating Systems

You can install vCenter Converter and vCenter Converter client only on Windows operating systems. vCenter Converter supports Windows and Linux operating systems as sources for powered-on-machine import and virtual-machine import and export. You cannot reconfigure Linux distributions.

For a list of operating systems on which you can install vCenter Converter components, see Table 2-1.

Table 2-1. Supported Operating Systems

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP Professional (32 bit and 64 bit) SP3</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows 2003 (32 bit and 64 bit) SP2, Revision 2</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Vista (32 bit and 64 bit) SP1</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table 2-1. Supported Operating Systems (Continued)

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2008 Server (32 bit and 64 bit)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows 7 (32 bit and 64 bit)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 2.1 (32 bit and 64 bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Linux Advanced Server 2.1 (32 bit and 64 bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 3.0 (32 bit and 64 bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 4.0 (32 bit and 64 bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 5.0 (32 bit and 64 bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 8.0 (32 bit and 64 bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 9.0 (32 bit and 64 bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 10.0 (32 bit and 64 bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 11.0 (32 bit and 64 bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ubuntu 5.x (32 bit and 64 bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ubuntu 6.x (32 bit and 64 bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ubuntu 7.x (32 bit and 64 bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ubuntu 8.x (32 bit and 64 bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

### Installation Space Requirements

During installation, you can select the vCenter Converter components that you want to install. All components require different disk space to install.

Table 2-2 shows the disk space required to install vCenter Converter and its components.
Table 2-2. Installation Space Requirements

<table>
<thead>
<tr>
<th>Installation Component</th>
<th>Disk Space Required</th>
<th>Disk Space Requirement for Decompressed Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation file</td>
<td>100MB</td>
<td>100MB</td>
</tr>
<tr>
<td>vCenter Converter client</td>
<td>25MB</td>
<td>25MB</td>
</tr>
<tr>
<td>vCenter Converter server</td>
<td>120MB</td>
<td>300MB</td>
</tr>
<tr>
<td>vCenter Converter agent</td>
<td>25MB</td>
<td>100M</td>
</tr>
</tbody>
</table>

**Supported Source Types**

With vCenter Converter, you can convert remote powered-on machines, powered-off VMware virtual machines, third-party virtual machines and system images, and Hyper-V virtual machines.

Table 2-3 shows the sources that vCenter Converter supports.

Table 2-3. Supported Sources

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Powered-on machines</td>
<td>Remote Windows physical machines</td>
</tr>
<tr>
<td></td>
<td>Remote Linux physical machines</td>
</tr>
<tr>
<td></td>
<td>Windows virtual machines running on Hyper-V Server</td>
</tr>
<tr>
<td></td>
<td>Windows virtual machines running on Citrix XenServer 4 Enterprise Edition</td>
</tr>
<tr>
<td></td>
<td>Windows virtual machines running on Virtual Iron version 4.2</td>
</tr>
<tr>
<td>VMware Infrastructure virtual machines</td>
<td>vCenter Server 4.0 and 4.1</td>
</tr>
<tr>
<td></td>
<td>ESX Server 3.5, 4.0, and 4.1</td>
</tr>
<tr>
<td></td>
<td>ESXi Server versions 3.5, 4.0, and 4.1 Installable and versions 3.5, 4.0, and 4.1 Embedded</td>
</tr>
<tr>
<td></td>
<td>ESX Server 2.5.x and 3.0 (if VirtualCenter 2.5 manages ESX)</td>
</tr>
<tr>
<td></td>
<td>VirtualCenter 2.5</td>
</tr>
<tr>
<td>VMware virtual machines</td>
<td>VMware Workstation 5.x and 6.x</td>
</tr>
<tr>
<td></td>
<td>VMware Fusion 2.x</td>
</tr>
<tr>
<td></td>
<td>VMware Player 2.x</td>
</tr>
<tr>
<td></td>
<td>VMware Server 2.x</td>
</tr>
</tbody>
</table>
### Table 2-3. Supported Sources (Continued)

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hyper-V Server virtual machines</td>
<td>Powered-off virtual machines with the following guest operating systems:</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2003 (32 bit and 64 bit)</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2008 (32 bit and 64 bit)</td>
</tr>
<tr>
<td></td>
<td>- Windows XP (32 bit and 64 bit)</td>
</tr>
<tr>
<td></td>
<td>- Windows Vista (32 bit and 64 bit)</td>
</tr>
<tr>
<td></td>
<td>- Windows 7</td>
</tr>
<tr>
<td></td>
<td>- SUSE Linux Enterprise Server 10</td>
</tr>
<tr>
<td>Third-party virtual machines or</td>
<td>Acronis True Image Echo 9.5, and Acronis True Image 11 (Home product) (.tib).</td>
</tr>
<tr>
<td>system images</td>
<td>Symantec Backup Exec System Recovery (formerly LiveState Recovery) 6.5, 7.0, 8.0, and 8.5,</td>
</tr>
<tr>
<td></td>
<td>LiveState Recovery 3.0 and 6.0 (.sv2i, .v2i or .iv2i). Supported only in vCenter Converter</td>
</tr>
<tr>
<td></td>
<td>server and agent for Windows.</td>
</tr>
<tr>
<td></td>
<td>- Norton Ghost version 10.0, 11.0, 12.0, 13.0, and 14.0 (.sv2i format only).</td>
</tr>
<tr>
<td></td>
<td>- Parallels Desktop for Microsoft Windows and Mac OS X 2.x and 3.x (.pvs and .hdd).</td>
</tr>
<tr>
<td></td>
<td>- Parallels Workstation 2.x (.pvs). Compressed disks are not supported.</td>
</tr>
<tr>
<td></td>
<td>- StorageCraft ShadowProtect Desktop, Server, SBS, IT Edition, versions 2.0, 2.5, 3.0, 3.1,</td>
</tr>
<tr>
<td></td>
<td>and 3.2 (.spf).</td>
</tr>
<tr>
<td></td>
<td>- Microsoft VHD format</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Virtual PC 2004, Microsoft Virtual PC 2007 (.vmc)</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Virtual Server 2005 and 2005 R2 (.vmc)</td>
</tr>
<tr>
<td>You must power off source virtual</td>
<td>You must power off source virtual machines before you convert them. You can convert</td>
</tr>
<tr>
<td>machines before you convert them.</td>
<td>running virtual machines if you treat them as powered-on machines.</td>
</tr>
<tr>
<td>Sources that run Windows 7 can be</td>
<td>Windows 7 can be converted to ESX 4.0 or later destinations. ESX 3.x does not support</td>
</tr>
<tr>
<td>converted to ESX 4.0 or later</td>
<td>Windows 7.</td>
</tr>
<tr>
<td>destinations. ESX 3.x does not support</td>
<td>Because vCenter Converter does not support OVF image sources and destinations, you can keep</td>
</tr>
<tr>
<td>Windows 7.</td>
<td>your installation of vCenter Converter Standalone 4.0.1 to convert your OVF images. The</td>
</tr>
<tr>
<td></td>
<td>client components of vCenter Converter Standalone 4.0.1 and vCenter Converter 4.2 can</td>
</tr>
<tr>
<td></td>
<td>coexist in the same system.</td>
</tr>
</tbody>
</table>

### Conversion Limitations for Powered-On Machines

When you convert a powered-on machine, some conversion features might not be available for certain source operating systems.

For a list of limitations dependent on the source operating system, see Table 2-4.

<table>
<thead>
<tr>
<th>Source Operating System</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP and later</td>
<td>Synchronization is supported only for volume-based cloning at the block level.</td>
</tr>
<tr>
<td>Linux</td>
<td>Only volume-based cloning at the file level is supported.</td>
</tr>
<tr>
<td></td>
<td>Only managed destinations are supported.</td>
</tr>
<tr>
<td></td>
<td>You can convert multiboot virtual machines only if GRUB is installed as the boot loader. LILO is not supported.</td>
</tr>
</tbody>
</table>

### Conversion Limitations for Virtual Machines

Certain limitations exist when you convert a virtual machine. These limitations depend on the type of operating system on which you run vCenter Converter.

You must power off source virtual machines before you convert them. You can convert running virtual machines if you follow the procedure for converting powered-on machines.
For a list of limitations dependent on the operating system where vCenter Converter server runs, see Table 2-5.

### Table 2-5. Virtual Machine Conversion Limitations

<table>
<thead>
<tr>
<th>Host Operating System</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2003</td>
<td>Disk-based cloning only for Linux guests.</td>
</tr>
<tr>
<td>Windows XP</td>
<td>Reconfiguration or customization for Linux guests is not supported.</td>
</tr>
<tr>
<td>Windows Vista</td>
<td>VMware Tools installation for Linux guests is not supported.</td>
</tr>
<tr>
<td>Windows Server 2008</td>
<td></td>
</tr>
</tbody>
</table>

### Conversion Limitations for Third-Party Virtual Machines or System Images

vCenter Converter can convert third-party virtual machines, system images, ShadowProtect images, and BackupExec System Recovery images. These conversions have limitations.

#### Third-Party Virtual Machines and System Images

Third-party virtual machines and system images have the following limitations.

- Virtual machines from Macintosh versions of Virtual PC are not supported.
- The operating system on the source Virtual PC or Virtual Server virtual machine must be a Windows guest operating system supported by the intended VMware platform (for example, Workstation 5 or 6.0.x). For a list of supported operating systems, see the Guest Operating System Installation Guide.
  
vCenter Converter supports Virtual PC and Virtual Server virtual machines with most Windows operating systems earlier than Windows NT 4.0 and with non-Windows operating systems (for example, Linux and DOS) only for cloning. vCenter Converter does not support configuring for these systems.
- Parallels Virtuozzo containers are not supported.

#### ShadowProtect and Backup Exec System Recovery

ShadowProtect and Backup Exec System Recovery have the following limitations.

- Dynamic disks are not supported.
- All images for the backup of a machine must be in a single folder. The source folder must not contain other images that are not part of the backup.
- For volume-based cloning, all volumes in the disk up to the active and system volumes must be backed up. For example, if a disk has four partitions, 1 through 4, with partition 2 as the active volume and partition 3 as the system volume, the backup must include partitions 1 through 3.
- For incremental images, up to 16 incremental backups are supported.
- Images of systems with logical drives are not supported if the logical drive is also a system or active volume (ShadowProtect only).

### Supported Destination Types

With vCenter Converter, you can create virtual machines compatible with VMware hosted and managed products.

Table 2-6 shows the destinations that vCenter Converter supports.
Table 2-6. Supported Destinations

<table>
<thead>
<tr>
<th>Destination Type</th>
<th>Supported Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware Infrastructure virtual machines</td>
<td>Managed destinations</td>
</tr>
<tr>
<td></td>
<td>• ESX Server 3.5, 4.0, and 4.1</td>
</tr>
<tr>
<td></td>
<td>• ESXi 3.5, 4.0, and 4.1 Installable and ESXi 3.5, 4.0, and 4.1</td>
</tr>
<tr>
<td></td>
<td>• vCenter Server 2.5, 4.0, and 4.1</td>
</tr>
<tr>
<td>VMware Hosted virtual machines</td>
<td>Hosted destinations</td>
</tr>
<tr>
<td></td>
<td>• VMware Workstation 5.x, 6.x, and 7.0</td>
</tr>
<tr>
<td></td>
<td>• VMware Fusion 2.x and 3.0</td>
</tr>
<tr>
<td></td>
<td>• VMware Player 2.x and 3.0</td>
</tr>
<tr>
<td></td>
<td>• VMware Server 2.x</td>
</tr>
</tbody>
</table>

**NOTE** For hosted destinations that reside on SMB or NFS shares, you must use volume-based cloning and create 2GB disks that are not pre-allocated.

Configuring Permissions for VirtualCenter Users

To convert virtual machines to vCenter with Converter, you must have the following vCenter permissions set at the datacenter level.

- **Datastore.Browse Datastore**
- **Virtual Machine.Inventory and Virtual Machine.Configuration**
- **Virtual Machine.Interaction.Power On** (needed only if you choose to power on the target virtual machine after conversion)
- **Virtual Machine.Provisioning.Allow Disk Access**

For more information about setting permissions, see the *vSphere Datacenter Administration Guide*.

Support for IPv6 in vCenter Converter

vCenter Converter supports both IPv4 and IPv6 Internet Protocols with several limitations.

Internet Protocol version 6 (IPv6 or IPng) is the successor to Internet Protocol version 4 (IPv4), which is the currently used protocol for assigning IP addresses to computers on the Internet. IPv6 was adopted to overcome the expected exhaustion of IPv4 addresses that might be caused by the constantly increasing number of computers on the Internet.

While IPv4 uses 32 bit addresses, IPv6 uses 128 bit. IPv6 addresses can have different formats or notations.

- 1040:0:0:0:0:0:0:1
- 1040::1
- 21DA:00D3:0010:2F3B:02AA:00FF:FE28:9C5A
- http://[2001:0db8:85a3:08d3:1319:8a2e:0370:7344]/
- https://[2001:0db8:85a3:08d3:1319:8a2e:0370:7344]:443/

vCenter Converter supports all IPv6 notations for all components of the system.

- vCenter Converter installer
- vCenter Converter client plug-in
vCenter Converter agent

All destinations supported in vCenter Converter

Along with the higher security level and much larger address space, IPv6 brings about some compatibility tasks that have not been resolved yet. For example, IPv4-only nodes cannot communicate directly with IPv6 nodes and need additional routing. This makes the end-to-end support of mixed IPv4 and IPv6 environments precarious.

To reduce this complexity, vCenter Converter supports only pure IPv6 or IPv4 environments, where the protection source, the protection destination, and the vCenter Converter server and agent must run the same version of IP.

**Note** You cannot use IPv6 to customize the guest operating systems of backup virtual machines.

### TCP/IP and UDP Port Requirements for Conversion

To enable conversion, the vCenter Converter server and client must be able to send data to each other, to remote physical machines, and to vCenter Server. Also, the source and target hosts must receive data from each other. Designated ports are reserved for this communication.

If any of these ports is blocked, the corresponding conversion task fails.

#### Ports Used When Importing a Powered-On Physical Machine Running Windows

Table 2-7 contains a list of the ports that must be open during the import of physical machine sources running Windows.

<table>
<thead>
<tr>
<th>Communication Paths</th>
<th>Communication Ports</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>vCenter Converter server to powered-on source machine</td>
<td>TCP - 445, 139, 9090</td>
<td>If the source computer uses NetBIOS, port 445 is not required. If NetBIOS is not being used, ports 137, 138, and 139 are not required. When in doubt, make sure that none of the ports are blocked. <strong>Note</strong> Unless you have installed vCenter Converter server or agent on the source computer, the account used for authentication to the source computer must have a password, network file sharing must be enabled on the source computer, and Simple File Sharing must not be used.</td>
</tr>
<tr>
<td>vCenter Converter server to vCenter Server</td>
<td>TCP - 443</td>
<td>Required only if the conversion destination is a vCenter Server.</td>
</tr>
<tr>
<td>vCenter Converter client to vCenter Server</td>
<td>TCP - 443</td>
<td>Required only if the vCenter Converter server and client components are on different machines.</td>
</tr>
<tr>
<td>Powered-on source machine to ESX/ESXi</td>
<td>TCP - 443, 902</td>
<td>If the conversion destination is vCenter Server, only port 902 is required.</td>
</tr>
</tbody>
</table>

#### Ports Used When Importing a Powered-On Physical Machine Running Linux

Table 2-8 contains a list of the ports that must be open during the import of physical machine sources running Linux.
### Table 2-8. Ports Required During Linux P2V

<table>
<thead>
<tr>
<th>Communication Paths</th>
<th>TCP Ports</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>vCenter Converter server to powered-on</td>
<td>22</td>
<td>Used to establish an SSH connection between the vCenter Converter and the source machine.</td>
</tr>
<tr>
<td>source machine</td>
<td></td>
<td></td>
</tr>
<tr>
<td>vCenter Converter client to vCenter Converter server</td>
<td>443</td>
<td>Required only if the vCenter Converter server and client components are on different machines.</td>
</tr>
<tr>
<td>vCenter Converter server to vCenter Server</td>
<td>443</td>
<td>Required only if the conversion destination is a vCenter Server.</td>
</tr>
<tr>
<td>vCenter Converter server to ESX/ESXi</td>
<td>443, 902, 903</td>
<td>If the conversion destination is a vCenter Server, only ports 902 and 903 are required.</td>
</tr>
<tr>
<td>vCenter Converter server to helper virtual machine</td>
<td>443</td>
<td>Used to establish an SSH connection between the helper virtual machine and the source machine. By default, the IP address of the helper virtual machine is assigned by DHCP. If no DHCP server is available on the destination network, you must manually assign the target virtual machine an IP address.</td>
</tr>
<tr>
<td>Helper virtual machine to powered-on source machine</td>
<td>22</td>
<td></td>
</tr>
</tbody>
</table>

### Ports Used When Importing or Exporting Virtual Machine Sources

Table 2-9 contains a list of the ports that must be open during the import and export of virtual machines.

### Table 2-9. Ports Required During V2V

<table>
<thead>
<tr>
<th>Communication Paths</th>
<th>Communication Ports</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>vCenter Converter server to Fileshare path</td>
<td>TCP - 445, 139, UPD - 137, 138</td>
<td>Required only for standalone virtual machine sources or destinations. If the computer hosting the source or destination path uses NetBIOS, port 445 is not required. If NetBIOS is not being used, ports 137, 138, and 139 are not required. When in doubt, make sure that none of the ports are blocked.</td>
</tr>
<tr>
<td>vCenter Converter client to vCenter Converter server</td>
<td>TCP - 443</td>
<td>Required only if the vCenter Converter server and client components are on different machines.</td>
</tr>
<tr>
<td>vCenter Converter server to vCenter Server</td>
<td>TCP - 443</td>
<td>Required only if the conversion destination is a vCenter Server.</td>
</tr>
<tr>
<td>vCenter Converter server to ESX/ESXi</td>
<td>TCP - 443, 902</td>
<td>If the conversion destination is a vCenter Server, only port 902 is required.</td>
</tr>
</tbody>
</table>

### Requirements for Remote Hot Cloning of Windows Operating Systems

To avoid problems related to permissions and network access, ensure that Simple File Sharing is turned off and that Windows Firewall does not block File and Printer Sharing. Also, to access File and Printer Sharing ports, you might need to change the scope of the IP addresses that the firewall allows.

To ensure successful remote hot cloning of Windows platforms, verify the following items on the source machine before you start the application:

- Ensure that Simple File Sharing is turned off.
- Ensure that file and printer sharing is not blocked by Windows Firewall.
You must allow incoming file share connections in the following cases:

- When you use the machine to host standalone images
- When you use the machine as a standalone destination
- When you remotely hot clone the machine

To enable customization of the guest operating system, install Sysprep files on the machine where vCenter Converter server runs.

Ensure that Windows Firewall Does Not Block File and Printer Sharing

If vCenter Converter fails to connect to a remote Windows XP machine and issues a bad username/password error message, ensure that file and printer sharing is not blocked by Windows Firewall.

**Procedure**

2. In the Security Settings list to the left, select Local Policies > Security Options.
3. In the policies list to the right, select Network access: Sharing and Security model for local accounts.
4. Verify that Classic – local users authenticate as themselves is selected.

**What to do next**

For troubleshooting information about File and Printer Sharing, search the Microsoft TechNet Web site.

For information about setting File and Printer Sharing on other Windows systems, see the documentation for your system.

Turn Off Simple File Sharing on Windows XP Professional

To control permissions for individual users, you must turn off Simple File Sharing on the source machine.

Turning Simple File Sharing off does not turn off the Shared Documents feature. Use the Simple File Sharing UI, located in the folder’s properties, to configure share and file permissions.

For Windows XP Professional operating systems that are part of a workgroup, the Simple File Sharing UI is turned on by default. Windows XP Professional operating systems that are part of a domain use only the classic file sharing and security interface.

**Procedure**

1. On the source machine, select Start > Settings > Control Panel > Folder Options.
2. Click the View tab and deselect Use Simple File Sharing (Recommended).

Simple File Sharing is turned off.

**What to do next**

For more information about turning simple file sharing on or off, see the Microsoft TechNet Web site.
Prepare for Customization of the Guest Operating System

To customize the guest operating system of a virtual machine that runs Windows Server 2003 or Windows XP, you must save the Sysprep files to the specified locations on the machine where vCenter Converter server runs. If Sysprep files are missing from the server machine, the Customize Guest OS option is not accessible in the vCenter Converter wizards.

Prerequisites

You must download the Sysprep files that correspond to the operating system of the source machine.

Procedure

- Save the Sysprep files to the specified location for the Destination OS or Guest OS.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2003 (32 bit)</td>
<td>The Sysprep Files Location for Windows: %ALLUSERSPROFILE% \Application Data\VMware\VMware vCenter Converter\sysprep \svr2003</td>
</tr>
<tr>
<td>Windows Server 2003 (64 bit)</td>
<td>The Sysprep Files Location for Windows: %ALLUSERSPROFILE% \Application Data\VMware\VMware vCenter Converter\sysprep \svr2003-64</td>
</tr>
<tr>
<td>Windows XP (32 bit)</td>
<td>The Sysprep Files Location for Windows: %ALLUSERSPROFILE% \Application Data\VMware\VMware vCenter Converter\sysprep \xp</td>
</tr>
<tr>
<td>Windows XP (64 bit)</td>
<td>The Sysprep Files Location for Windows: %ALLUSERSPROFILE% \Application Data\VMware\VMware vCenter Converter\sysprep \xp-64</td>
</tr>
</tbody>
</table>

What to do next

Now you can customize the guest operating system of a virtual machine by using the Import Machine, Export Virtual Machine, or the Reconfigure Virtual Machine wizard.

Limitations Related to Creating Snapshots of Windows Sources

vCenter Converter uses VSS snapshots to save the state of source volumes during hot cloning of physical and virtual machines that run Windows. VSS snapshots are also used to synchronize the destination virtual machine with the source machine after the initial conversion. Some of the VSS-related issues are inherited in vCenter Converter and can prevent the proper completion of your conversion tasks.

Read the limitations listed in Table 2-10 before you initiate a conversion task.

If your conversion task fails with an VSS-related error message, you can check the table for possible reasons and workarounds.

<table>
<thead>
<tr>
<th>Table 2-10. VSS Snapshotting Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>VSS Limitations</td>
</tr>
<tr>
<td>-----------------</td>
</tr>
<tr>
<td>For all operating systems that support volume-based cloning, you need at least one NTFS volume for VSS to work.</td>
</tr>
<tr>
<td>VSS under Windows Server 2008 does not support FAT/FAT32.</td>
</tr>
<tr>
<td>VSS Limitations</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| VSS under Windows Server 2008 does not support unformatted or unrecognized volumes. | Failed to create VSS snapshot of source volume. Error code: 2147754764 (0x8004230C) | - Format all unformatted or unrecognized volumes and try the conversion again.  
- Deselect all unformatted or unrecognized volumes while setting up the conversion task in the Data to copy pane of the View/Edit Options page. |
| If there is not enough space in the VSS snapshot storage area for the VSS to create a snapshot, the conversion fails. | Failed to create VSS snapshot of source volume. Error code: 2147754783 (0x8004231F) | Clean up the source volumes, especially the system volume and all NTFS volumes, and try to convert the source again. |
| Importing powered-on Hyper-V sources fails if the following two VSS services are not started or are not operating properly on the source machine: | Failed to create VSS snapshot of source volume. Error code: 2147754758 (0x80042306) | 1. Set the starting mode for Microsoft Software Shadow Copy Provider Service and Volume Shadow Copy Service to Automatic.  
2. Restart the source machine and try cloning it again. |
This information describes the basic steps to install and uninstall the vCenter Converter components.

Because vCenter Converter does not support OVF image sources and destinations, you can keep your installation of vCenter Converter Standalone 4.0.1 to convert your OVF images. The client components of vCenter Converter Standalone 4.0.1 and vCenter Converter 4.2 can coexist in the same system.

This chapter includes the following topics:

- “Install vCenter Converter,” on page 31
- “Install the vCenter Converter Client,” on page 32
- “Enable or Disable the vCenter Converter Client,” on page 33
- “Uninstall vCenter Converter Components,” on page 33
- “Uninstall the vCenter Converter Client by Using the Windows Add or Remove Programs Utility,” on page 34

Install vCenter Converter

You can use the vCenter Server installer or the vCenter Converter installer to add vCenter Converter functionality to the vCenter Server 4.1 environment.

The process for installing with the vCenter Converter installer is described here. The process for installing the vCenter Converter plug-in as part of the vCenter Server installation process is described in the ESX and vCenter Server Installation Guide.

Prerequisites

Before you install vCenter Converter, confirm the following items:

- Verify that your hardware meets the vCenter Converter system requirements and that the operating system is supported. See “Installation Space Requirements,” on page 20 and “Supported Operating Systems,” on page 19.

- Make sure that the vCenter Server is powered on and that you have your login credentials to enter during the installation process. vCenter Converter requires a connection to vCenter Server 4.1.
Procedure

1. Locate the vCenter Converter installer on the vSphere installation CD.
2. Double-click the `VMware-Converter.exe` file and click **Next**.
   - If a dialog box appears with **Modify**, **Repair**, or **Remove**, the installer detected a previous vCenter Converter installation.
   - If only vCenter Converter server is installed on the machine, the dialog prompts you to remove the vCenter Converter server.
4. On the End-User License Agreement page, select **I accept the terms in the License Agreement** and click **Next**.
5. Select the location folder for vCenter Converter on the Destination Folder page and click **Next**.
   - The default location is `C:\Program Files\VMware\VMware vCenter Converter`.
6. Enter FQDN, the IP address and port number, or the host name for the vCenter Server to connect to.
   - If the default port (443) is already in use, enter an alternative port.
   - Each installation of vCenter Converter server must be associated with only one vCenter Server.
7. Enter the user name and password for the vCenter Server and click **Next**.
8. Enter the vSphere Client Web service ports or use the default ports and click **Next**.
   - HTTPS (default is 443)
   - HTTP (default is 80)
   - These ports allow communication between vCenter Converter components. If the default ports are already in use, enter alternative ports.
9. Select a DNS name, an IP address, or a host name to identify the vCenter Converter server on the network and click **Next**.
10. On the Ready to Install the Program page, click **Install**.
    - If you click **Cancel** during the installation, the installed files are removed and the operating system is returned to its original state.
11. When the Installation Completed page appears, click **Finish**.

vCenter Converter is installed and the vCenter Converter client appears in the Available Plug-ins list of the vSphere Plug-in Manager.

**What to do next**

You can now install the vCenter Converter client. See “Install the vCenter Converter Client,” on page 32.

**Install the vCenter Converter Client**

After you install the vCenter Converter server and register it with vCenter Server, the vCenter Converter client is available to the vCenter Server client. You can access the vCenter Converter Import Machine, Export Machine, and Reconfigure wizards, and manage conversion tasks by using the vCenter Converter client.

**Prerequisites**

Before you install the vCenter Converter client, make sure that your hardware meets the vCenter Converter client system requirements. See “Installation Space Requirements,” on page 20 and “Supported Operating Systems,” on page 19.
Procedure
1. Start the vSphere Client and connect to the vCenter Server associated with vCenter Converter. You specified the associated vCenter Server when you installed vCenter Converter.

2. Select Plug-ins > Manage Plug-ins.

3. Select vCenter Converter in the Available Plug-ins list and click Download and install.

4. After the installation is complete, verify that the module appears in the Installed Plug-ins list and that it is enabled.

You can now access the vCenter Converter wizards to perform migrations in the vCenter Server environment.

Enable or Disable the vCenter Converter Client
To make the vCenter Converter client module available in the vSphere environment, you must enable it by using Plug-in Manager. After you enable the client, you can also use Plug-in Manager to disable it.

Disabling the plug-in does not uninstall it. Disabling turns off the features and functionality that the vCenter Converter client provides for the vSphere Client you are using. Plug-ins are enabled by default when they are installed.

Procedure
1. In the vSphere Client, select Plug-ins > Manage Plug-ins.

2. On the Installed tab, right-click vCenter Converter and select Enable or Disable.

If you enabled the vCenter Converter client, it is now accessible in the vSphere Client interface. The vCenter Converter Online Help is accessible from the Help menu.

What to do next
You can now use the vCenter Converter wizards to begin a conversion task.

Uninstall vCenter Converter Components
You can uninstall the vCenter Converter components by using the Windows Add or Remove Programs utility from Control Panel.

You can uninstall only one component at a time.

Procedure
1. Log in as an Administrator to the Windows computer on which vCenter Converter is installed.

2. Select Start > Settings > Control Panel > Add or Remove Programs.

3. Select a vCenter Converter component and click Remove.

4. Click Yes to confirm that you want to remove the program and click Finish.

vCenter Converter and its components are uninstalled.

What to do next
You can update the vCenter Converter components.
Uninstall the vCenter Converter Client by Using the Windows Add or Remove Programs Utility

You can uninstall the vCenter Converter client by using the Windows Add or Remove Programs utility in Control Panel.

The process for uninstalling vCenter Converter client by using the Windows Add or Remove Programs utility is described here. The process for uninstalling the vCenter Converter plug-in by using the vCenter Server install wizard is described in the Repair or Remove the vCenter Converter Client topic.

Procedure

1. Log in as an Administrator to the Windows computer on which the vCenter Converter client is installed.
2. Select Start > Settings > Control Panel > Add or Remove Programs.
3. Select VMware vCenter Converter Client 4.2 and click Remove.
4. Click Yes to confirm that you want to remove the program and click Finish.

The vCenter Converter client is uninstalled.
With vCenter Converter, you can import physical machines, VMware virtual machines, third-party backup images and virtual machines, and Hyper-V Server virtual machines into virtual machines that vCenter Server manages.

Procedure

1. **Start the Import Machine Wizard** on page 35
   The Import Machine wizard guides you through the steps of importing a virtual machine to a selected ESX host, cluster, resource pool, or virtual machine folder.

2. **Select a Source Machine to Import** on page 36
   You must select the type of source machine you want to import to your vCenter Server environment.

3. **Configure the Destination Location** on page 40
   You can configure the destination ESX settings. The settings include selecting an ESX host to store the destination virtual machine, entering a virtual machine name, selecting a virtual hardware version, selecting a datastore, and selecting a folder for the destination machine.

4. **Configure the Hardware of the Destination Virtual Machine** on page 41
   You can configure the virtual hardware resources that the destination virtual machine uses.

5. **Configure the Software of the Destination Virtual Machine** on page 48
   You can configure the guest operating system so that it is ready to operate in a virtual environment.

6. **Configure the Import Task** on page 53
   You can configure the conversion process and select the behavior of the source and destination machine during and after conversion. You can change the status of the source and destination services only when the source machine is running a Windows operating system.

7. **Schedule the Import Task** on page 56
   You can set the time at which you want an import task to start.

8. **Review the Summary and Submit the Import Task** on page 57
   On the Summary page, you can view a summary of the new conversion task before you add it to the task list.

**Start the Import Machine Wizard**

The Import Machine wizard guides you through the steps of importing a virtual machine to a selected ESX host, cluster, resource pool, or virtual machine folder.

The information that you must provide depends on way you start the wizard.
Procedure

- In the vSphere Client, start the Import Machine wizard.
  - On the main vSphere Client menu, select Inventory and select Host, Cluster, or Resource Pool, and then select Import Machine.
  - In the inventory Hosts & Clusters view, right-click a host, cluster, or resource pool, and select Import Machine.
  - In the inventory Virtual Machines and Templates view, right-click a folder and select Import Machine.
  - In the Scheduled Tasks view, select File > New > Scheduled Task. In the drop-down menu, select Import a machine.
  - In the Recent Tasks or Scheduled Tasks list, right-click an import task and select Copy As New.

The Import Machine wizard opens.

What to do next

Complete the wizard to add the conversion task to the task list.

Select a Source Machine to Import

You must select the type of source machine you want to import to your vCenter Server environment.

- Select a Powered-On Windows Machine to Import on page 36
  You can select a running (powered-on) Windows machine to import. The source machine can be physical or virtual.

- Select a Powered-On Linux Machine to Import on page 37
  You can select a powered-on Linux machine to import. The source machine can be a physical or virtual machine.

- Select an ESX/ESXi or vCenter Server Virtual Machine on page 38
  You can import a virtual machine that is located on an ESX/ESXi or on an ESX/ESXi managed by vCenter Server.

- Select a VMware Hosted Virtual Machine on page 38
  You can import a virtual machine created or used in a VMware hosted product, such as VMware Workstation, VMware Player, VMware Fusion, and VMware Server.

- Select a Backup Image or a Third-Party Virtual Machine on page 39
  You can import a backup image or a third-party virtual machine.

- Select a Hyper-V Server Virtual Machine on page 39
  You can import virtual machines that Hyper-V Server manages.

Select a Powered-On Windows Machine to Import

You can select a running (powered-on) Windows machine to import. The source machine can be physical or virtual.

Prerequisites

Before you continue, you must prepare the source Windows machine for import.

- Make sure that the Windows version installed on the powered-on machine is supported. For a list of supported operating systems, see “Supported Operating Systems,” on page 19.
- The vCenter Converter server machine must have network access to the Windows source machine.
- Turn off firewall applications running on the source machine.
- Disable file sharing on the source Windows machine.
- Make sure that no other conversion task is using the source you select.
- Manually remove any VMware Converter 3.x installations from the machine you are importing.
- If you plan to import a powered-on machine accessible via IPv6, ensure that vCenter Converter server is installed on Windows Vista, Windows 2008, or Windows 7 operating system.

**Procedure**

1. On the Source System page of the Import wizard, select **Powered-on machine** from the **Select source type** drop-down menu.
2. Provide the IP address and credentials for the Windows machine you want to import.
3. From the **OS Family** drop-down menu, select **Windows**.
4. (Optional) Click **View source details** to see hardware and software information about the source machine.
5. Click **Next**.
   
   If vCenter Converter agent is not already installed on the source machine, a dialog window appears, asking you to select an uninstallation method for vCenter Converter agent.
6. (Optional) Select the uninstallation procedure for vCenter Converter agent and click **Yes**.
   
   vCenter Converter agent is installed on the source machine.

vCenter Converter agent prepares the source machine for import.

**What to do next**

Modify the destination environment for the destination virtual machine.

---

**Select a Powered-On Linux Machine to Import**

You can select a powered-on Linux machine to import. The source machine can be a physical or virtual machine.

**Prerequisites**

Before you continue, you must prepare the source machine for import.

- Enable SSH on the source Linux machine.
- You must use the root account to import a Linux powered-on machine.
- The vCenter Converter server machine must have network access to the Linux source machine.
- Make sure that no other conversion task is using the source you select.

**Procedure**

1. On the Source System page of the Import Machine wizard, select **Powered-on machine** from the **Select source type** drop-down menu.
2. Provide the IP address and credentials for the Linux machine you want to import.
3. From the **OS Family** drop-down menu, select **Linux**.
4. Click **Next** to proceed to the Destination Location page.

vCenter Converter connects to the powered-on Linux machine and prepares it for import.

**What to do next**

Modify the destination environment for the destination virtual machine.
Select an ESX/ESXi or vCenter Server Virtual Machine

You can import a virtual machine that is located on an ESX/ESXi or on an ESX/ESXi managed by vCenter Server.

You cannot import a running or suspended virtual machine.

If you connect to a vCenter Server that is part of a multi-vCenter Server environment, vCenter Converter displays only ESX hosts managed directly by the currently connected vCenter Server.

Prerequisites

GRUB must be installed as the boot loader to convert multiboot virtual machines. LILO is not supported.

Procedure

1. On the Source System page of the Import Machine wizard, select VMware Infrastructure virtual machine from the Select source type drop-down menu.

2. Provide the IP address or host name and credentials for authentication with the ESX host or the vCenter Server.

3. Click Next.

The Source Machine page appears, displaying the IP address and the inventory of the ESX host or the vCenter Server.

4. From the inventory list, select the virtual machine to import.

Note: If you connect to a vCenter Server that has a disconnected ESX (powered off or connected to another vCenter Server), you cannot select a virtual machine from that ESX.

5. (Optional) If you are connected to a vCenter Server, select a virtual machine view from the Specify machine with drop-down menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hosts and Clusters View</td>
<td>Provides a view of the set of virtual machines that run on a particular host, cluster, or resource pool. This view does not provide a complete list of available virtual machines and templates in the vCenter Server.</td>
</tr>
<tr>
<td>VM and Templates View</td>
<td>Displays all virtual machines and templates in alphabetical order.</td>
</tr>
<tr>
<td>VM List</td>
<td>Provides an alphabetical list of all virtual machines and allows you to search them by name. Note: This search is not case-sensitive.</td>
</tr>
</tbody>
</table>

6. (Optional) To view more details about a machine, select it and click View source details.

7. Click Next to proceed to the Destination Location page.

What to do next

You can now configure the settings of the destination location.

Select a VMware Hosted Virtual Machine

You can import a virtual machine created or used in a VMware hosted product, such as VMware Workstation, VMware Player, VMware Fusion, and VMware Server.

Prerequisites

Verify that your machine is a supported VMware Desktop products virtual machine.
Procedure

1. On the Source System page, select **VMware Workstation or other VMware virtual machine** from the **Select source type** drop-down menu.

2. Provide a valid network path to the virtual machine file (.vmx) in the **Virtual machine file** text box.
   
   For example, `\server\virtual_machines\virtual_machine.vmx`.

   **IMPORTANT** The vCenter Converter server machine must be able to access the provided network path.

3. Enter credentials to access the network share where the file is located.

4. (Optional) If the network path and the credentials are valid, click **View source details** to view software and hardware details about the virtual machine.

5. Click **Next** to proceed to the Destination Location page.

**What to do next**

You can now configure the settings of the destination location.

---

**Select a Backup Image or a Third-Party Virtual Machine**

You can import a backup image or a third-party virtual machine.

**Prerequisites**

Verify that your machine is a supported backup image or third-party virtual machine.

**Procedure**

1. On the Source System page, select **Backup image or third-party virtual machine** from the **Select source type** drop-down menu.

2. Provide a valid network path to the backup image or virtual machine file in the **Virtual machine file** text box.

   For example, `\server\backup_images\backup_image.pvs`

   **NOTE** The vCenter Converter server machine must be able to access the provided network path.

3. Enter credentials to access the network share where the file is located.

4. (Optional) To view information about the selected source, click **View source details**.

5. Click **Next** to proceed to the Destination Location page.

**What to do next**

You can now configure the settings of the destination location.

---

**Select a Hyper-V Server Virtual Machine**

You can import virtual machines that Hyper-V Server manages.

**Prerequisites**

Power off the source Hyper-V virtual machine.

**Procedure**

1. On the Source System page, select **Hyper-V Server** from the **Select source type** drop-down menu.

2. Provide the IP address and credentials to authenticate with the Hyper-V Server.
3 Click Next.

If vCenter Converter agent is not already installed on the Hyper-V Server, a dialog box appears, asking you to select an uninstallation method for vCenter Converter agent.

4 (Optional) Select uninstallation procedure for vCenter Converter agent and click Yes.

vCenter Converter agent is installed on the Hyper-V Server.

5 On the Source Machine page, select a virtual machine from the list.

   **NOTE** You can select only powered-off virtual machines. To import a running machine, select a powered-on machine. To import a suspended machine, either power it off and use the current procedure, or power it on and select a powered-on machine as the source.

6 (Optional) To view more details about the virtual machine to import, click View source details.

vCenter Converter agent prepares Hyper-V machines for import.

**What to do next**

You can now configure the settings of the destination location.

**Configure the Destination Location**

You can configure the destination ESX settings. The settings include selecting an ESX host to store the destination virtual machine, entering a virtual machine name, selecting a virtual hardware version, selecting a datastore, and selecting a folder for the destination machine.

- **Customize the Location of the Destination Virtual Machine** on page 40
  You can customize the location settings for the destination virtual machine. The settings include selecting an ESX host, a resource pool, or a cluster, naming the virtual machine, selecting a datastore, and selecting a virtual machine hardware version.

- **Select a Virtual Machine Folder** on page 41
  If you use folders in your virtual environment to manage groups of virtual machines, you can select a folder to accommodate the destination virtual machine.

**Customize the Location of the Destination Virtual Machine**

You can customize the location settings for the destination virtual machine. The settings include selecting an ESX host, a resource pool, or a cluster, naming the virtual machine, selecting a datastore, and selecting a virtual machine hardware version.

**Procedure**

1 On the Destination Location page, select a datacenter object from the inventory to accommodate the destination virtual machine.

   - Select an ESX host.
   - Select a resource pool.
   - Select a cluster.

2 In the **Virtual machine name** text box, enter a name for the destination virtual machine.

3 If the cluster you selected is not automated, you can select an ESX host that belongs to the selected cluster from the **Host** drop-down menu.

4 Select a datastore from the **Datastore** drop-down menu.

   The selected datastore stores the virtual machine files.
Select the virtual hardware version for the destination virtual machine from the **Virtual machine version** drop-down menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version 4</td>
<td>Select when sharing storage or virtual machines with ESX 3.x versions.</td>
</tr>
<tr>
<td>Version 7</td>
<td>Select for the latest virtual machine features. This hardware version is not supported for ESX 3.x versions.</td>
</tr>
</tbody>
</table>

6. Click **Next**.

The location of the destination virtual machine is set up.

### Select a Virtual Machine Folder

If you use folders in your virtual environment to manage groups of virtual machines, you can select a folder to accommodate the destination virtual machine.

**Prerequisites**

You must have a virtual machine folder in vCenter Server to store the destination virtual machine.

**Procedure**

1. On the Options page, select **Destination attributes** from the options list.
2. Select a folder from the folder list in the right panel.
3. To save your settings, select another option from the options list or click **Next**.

After the conversion, the destination virtual machine is located in the selected virtual machine folder.

### Configure the Hardware of the Destination Virtual Machine

You can configure the virtual hardware resources that the destination virtual machine uses.

- **Copy Disks or Volumes** on page 42
  
  You can copy all disks to the destination or select which volumes to be copied and which to be excluded.

- **Edit the Number of Processors** on page 46
  
  You can change the number of processors that the destination virtual machine uses.

- **Allocate Memory for the Destination Virtual Machine** on page 47
  
  You can change the amount of memory allocated to the destination virtual machine.

- **Specify a Disk Controller for the Destination Virtual Machine** on page 47
  
  You can select a disk controller type for the destination virtual disks.

- **Configure the Network Settings of the Destination Virtual Machine** on page 48
  
  You can change the number of network adapters and set the network that the destination virtual machine uses. You can also set network adapters to connect to the network when the destination virtual machine powers on.

- **Configure the Network for the Helper Virtual Machine** on page 48
  
  When you import a Linux powered-on machine, vCenter Converter creates a Helper virtual machine on the destination. The Helper virtual machine needs network access to the source machine to clone the source files. Default conversion settings enforce automatic acquisition of an IP address and a DNS server for the Helper virtual machine, but you can set up this network connection manually.
Copy Disks or Volumes

You can copy all disks to the destination or select which volumes to be copied and which to be excluded.
vCenter Converter supports disk-based and volume-based cloning.

- **Resize a Volume** on page 43
  To manage disk space on the destination datastore, you can resize the disk volumes before you begin the conversion.

- **Delete a Volume** on page 43
  You can choose to delete a volume from the destination virtual machine. During the conversion process, vCenter Converter ignores the deselected volumes and copies only the volumes that are selected.

- **Move a Volume to a Different Virtual Disk** on page 43
  You can add a virtual disk to the destination virtual machine and accommodate a volume in the new disk.

- **Move a Volume to a Different Datastore** on page 44
  You can store a disk volume in a datastore different from the one that accommodates the virtual machine configuration file (.vmx).

- **Add a Virtual Disk** on page 44
  You can add a virtual disk to the destination virtual machine.

- **Move a Disk to a Different Datastore** on page 45
  You can store the destination virtual disks in separate datastores.

- **Create an Expandable Disk on a Managed Destination** on page 45
  To save space on the destination datastore, you can copy only the existing data from a source virtual disk and create an expandable disk on the destination. Later, as you use the destination virtual machine and write new data, the destination virtual disk grows.

- **Delete a Disk** on page 46
  You can select a disk from the source machine and delete it from the disk layout of the destination virtual machine.

- **Copy All Disks to the Destination** on page 46
  To preserve the source disks on the destination virtual machine, you can copy all disks to the destination.

**Procedure**

- On the Options page, select a copy mode from the **Data copy type** drop-down menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy all disks and maintain layout</td>
<td>Performs disk-based cloning. You can preserve the source disk layout in the destination virtual machine.</td>
</tr>
<tr>
<td>Select volumes to copy</td>
<td>Performs volume-based cloning. You can select which volumes to copy to the destination virtual machine. You can also resize and reorganize the volume layout.</td>
</tr>
</tbody>
</table>

**NOTE** The options available depend on your source and destination selection.

The Data to copy options change as you select a different option.
Resize a Volume

To manage disk space on the destination datastore, you can resize the disk volumes before you begin the conversion.

Procedure

1. On the Options page of the Import Machine wizard, select Data to copy.
2. From the Data copy type drop-down menu, select Select volumes to copy.
3. In the Destination size column, select an option to specify the size of a destination volume.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain size</td>
<td>Maintains the original source volume size.</td>
</tr>
<tr>
<td>Min size</td>
<td>Copies only the used space of the source volume.</td>
</tr>
<tr>
<td>Type size in GB</td>
<td>Allows you to type a custom size in GB for the destination volume. The value cannot be smaller than the used space on the source volume, but can be larger than its total size. The maximum allowed disk size is 999 GB. The volume size can be as large as the disk size, depending on your configuration.</td>
</tr>
<tr>
<td>Type size in MB</td>
<td>Allows you to type a custom size in MB for the destination volume. The value cannot be smaller than the used space on the source volume, but can be larger than its total size. The maximum allowed disk size is 999 GB. The volume size can be as large as the disk size, depending on your configuration.</td>
</tr>
</tbody>
</table>

4. To save your settings, select another option from the options list or click Next.

Delete a Volume

You can choose to delete a volume from the destination virtual machine. During the conversion process, vCenter Converter ignores the deselected volumes and copies only the volumes that are selected.

You cannot delete the system volume from the destination virtual machine. For example, if C: is the volume that contains the Windows operating system installation, you cannot remove it from the destination virtual machine.

Prerequisites

The source virtual machine must have more than one volume to be able to deselect existing volumes.

Procedure

1. On the Options page of the Import Machine wizard, select Data to copy.
2. From the Data copy type drop-down menu, select Select volumes to copy.
3. Deselect the volumes that you do not want to copy to the destination virtual machine.
4. To save your settings, select another option from the options list or click Next.

The deselected volumes are ignored during the conversion process.

Move a Volume to a Different Virtual Disk

You can add a virtual disk to the destination virtual machine and accommodate a volume in the new disk.

The number of virtual disks depends on the number of volumes that exist on the source virtual machine. For example, if you have only one volume on the source virtual machine, you cannot add a virtual disk to the destination virtual machine.

You cannot move the system volume where the guest operating system is installed. For example, if your Windows operating system is installed on C:, you cannot move the C: volume.
Procedure

1. On the Options page of the Import Machine wizard, select Data to copy.
2. From the Data copy type drop-down menu, select Select volumes to copy.
3. Click Advanced and select the Destination layout tab.
4. Select a volume from the list and click Add disk.
   vCenter Converter creates a new virtual disk.
5. Select a volume and use the Move up and Move down buttons to accommodate the volume in the new virtual disk.
   If you leave the new virtual disk empty, vCenter Converter does not create the new virtual disk on the destination virtual machine.
6. To save your settings, select another option from the options list or click Next.
   The volume is moved to the new virtual disk.

**Move a Volume to a Different Datastore**

You can store a disk volume in a datastore different from the one that accommodates the virtual machine configuration file (.vmx).

Procedure

1. On the Options page of the Import Machine wizard, select Data to copy.
2. From the Data copy type drop-down menu, select Select volumes to copy.
3. Click Advanced and select the Destination layout tab.
4. Select a volume from the list and click Add disk.
   vCenter Converter creates a new virtual disk.
5. Select a volume and use the Move up and Move down buttons to accommodate the volume in the new virtual disk.
   If you leave the new virtual disk empty, vCenter Converter does not create the new virtual disk on the destination virtual machine.
6. Highlight the new virtual disk and select a different datastore from the Destination datastore drop-down menu.
7. To save your settings, select another option from the options list or click Next.
   The virtual disk file (.vmdk) that contains the volume is stored in the selected datastore.

**Add a Virtual Disk**

You can add a virtual disk to the destination virtual machine.

The number of virtual disks depends on the number of volumes that exist on the source virtual machine. For example, if you have only one volume on the source virtual machine, you cannot add a virtual disk to the destination virtual machine.

**Prerequisites**

You must have more than one volumes on the source machine to add an additional virtual disk.
**Procedure**

1. On the Options page of the Import Machine wizard, select **Data to copy**.
2. From the **Data copy type** drop-down menu, select **Select volumes to copy**.
3. Click **Advanced** and select the **Destination layout** tab.
4. Select a volume from the list and click **Add disk**.
   A virtual disk is added to the destination disk layout.
5. Select a volume and use the **Move up** and **Move down** buttons to accommodate the volume in the new virtual disk.
   If you leave the new virtual disk empty, vCenter Converter does not create the new virtual disk on the destination virtual machine.
6. To save your settings, select another option from the options list or click **Next**.

The new virtual disk is created on the destination datastore.

### Move a Disk to a Different Datastore

You can store the destination virtual disks in separate datastores.

**Prerequisites**

Use disk-based cloning to select a different datastore for a virtual disk.

**Procedure**

1. On the Options page of the Import Machine wizard, select **Data to copy**.
2. From the **Data copy type** drop-down menu, select **Copy all disks and maintain layout**.
3. Highlight a virtual disk to relocate and select a different datastore from the **Destination datastore** drop-down menu.
4. To save your settings, select another option from the options list or click **Next**.

The virtual disk file (.vmdk) is stored in the selected datastore.

### Create an Expandable Disk on a Managed Destination

To save space on the destination datastore, you can copy only the existing data from a source virtual disk and create an expandable disk on the destination. Later, as you use the destination virtual machine and write new data, the destination virtual disk grows.

You can create an expandable disk by using volume-based and disk-based cloning.

**Procedure**

1. On the Options page of the Import Machine wizard, select **Data to copy**.
2. Use disk-based cloning to create an expandable disk.
   a. From the **Data copy type** drop-down menu, select **Copy all disks and maintain layout**.
   b. Highlight a virtual disk and select **Thin** from the **Type** drop-down menu.
3. Use volume-based cloning to create an expandable disk.
   a. From the **Data copy type** drop-down menu, select **Select volumes to copy** and click **Advanced**.
   b. Select the **Destination layout** tab, highlight a virtual disk, and select **Thin** from the **Type** drop-down menu.
4. To save your settings, select another option from the options list or click **Next**.
vCenter Converter copies only the existing data to the destination datastore. The empty disk space from the virtual disk is not copied to the datastore. As you use the destination virtual machine and write new data to the disk, the size of the destination disk grows.

**Delete a Disk**

You can select a disk from the source machine and delete it from the disk layout of the destination virtual machine.

**Prerequisites**

The source machine must have more than one hard disk.

**Procedure**

1. On the Options page of the Import Machine wizard, select *Data to copy*.
2. From the *Data copy type* drop-down menu, select *Select volumes to copy*.
3. Delete the disk.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Preserve the volumes associated with the disk** | a. Click *Advanced* and select the *Destination layout* tab.  
b. Move the volumes from the disk you want to delete to another virtual disks.  
c. Highlight the empty disk and click *Remove disk*. |
| **Delete the volumes associated with the disk** | a. Click *Advanced* and select the *Source volumes* tab.  
b. Deselect the volumes associated with the disk that you want to delete. |

4. To save your settings, select another option from the options list or click *Next*.

vCenter Converter creates .vmdk files in the destination datastore only for the virtual disks you selected to preserve.

**Copy All Disks to the Destination**

To preserve the source disks on the destination virtual machine, you can copy all disks to the destination.

Disk-based cloning is not available for powered-on machine sources.

**Procedure**

1. On the Options page of the Import Machine wizard, select *Data to copy*.
2. From the *Data copy type* drop-down menu, select *Copy all disks and maintain layout*.
3. (Optional) If the destination datastore is low on disk space, highlight a virtual disk and select a different datastore from the *Destination datastore* drop-down menu.

   **Note**: You must have more than one datastore to move a disk to a different datastore.

4. To save your settings, select another option from the options list or click *Next*.

vCenter Converter copies the disks to the selected datastores and preserves the source disk layout.

**Edit the Number of Processors**

You can change the number of processors that the destination virtual machine uses.

**Prerequisites**

Make sure the destination host and the guest operating system support the number of processors you assign to the destination virtual machine.
Procedure
1. On the Options page of the Import Machine wizard, select **Devices** from the options list.
2. From the **Number of processors** drop-down menu, select the processor count for the destination virtual machine.
3. To save your settings, select another option from the options list or click **Next**.

The destination virtual machine is configured with the number of processors that you selected. If vCenter Converter shows a message that the destination hardware does not support the number of processors you selected, you must select a supported number of processors.

### Allocate Memory for the Destination Virtual Machine

You can change the amount of memory allocated to the destination virtual machine.

By default, vCenter Converter recognizes the amount of memory on the source machine and allocates it to the destination virtual machine.

Procedure
1. On the Options page of the Import Machine wizard, select **Devices** from the options list.
2. In the **Memory** panel, use the slider or the spin-box to specify the amount of memory for the destination virtual machine.
3. To save your settings, select another option from the options list or click **Next**.

vCenter Converter validates the memory amount. A warning appears if you set the memory amount to more than the maximum supported or to less than the required minimum.

### Specify a Disk Controller for the Destination Virtual Machine

You can select a disk controller type for the destination virtual disks.

Procedure
1. On the Options page of the Import Machine wizard, select **Devices** from the options list.
2. From the **Disk controller** drop-down menu, select a disk controller for the destination virtual disk.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCSI Bus Logic</td>
<td>Use SCSI virtual disks in the destination virtual machine.</td>
</tr>
<tr>
<td>IDE</td>
<td>Use IDE virtual disks in the destination virtual machine.</td>
</tr>
<tr>
<td>Preserve source</td>
<td>Use the same type of disk controllers that are installed on the source machine.</td>
</tr>
</tbody>
</table>

**Note**: If you are importing a powered-on Linux machine, you cannot change the original disk controller type.

3. To save your settings, select another option from the options list or click **Next**.
Configure the Network Settings of the Destination Virtual Machine

You can change the number of network adapters and set the network that the destination virtual machine uses. You can also set network adapters to connect to the network when the destination virtual machine powers on.

Procedure

1. On the Options page of the Import Machine wizard, select **Networks** from the options list.
2. From the **Network adapters to connect** drop-down menu, select the number of network adapters to be used by the destination virtual machine.
3. Use the **Network** drop-down menu to select the network the adapter connects to.
4. To connect an adapter when you power on the destination virtual machine, select the **Connect at power-on** check box.
5. To save your settings, select another option from the options list or click **Next**.

Configure the Network for the Helper Virtual Machine

When you import a Linux powered-on machine, vCenter Converter creates a Helper virtual machine on the destination. The Helper virtual machine needs network access to the source machine to clone the source files. Default conversion settings enforce automatic acquisition of an IP address and a DNS server for the Helper virtual machine, but you can set up this network connection manually.

Procedure

1. On the Options page of the Import Machine wizard, click **Helper VM network**.
2. On the **Network** tab, select **Use the following IP address** to assign a static IP address to the Helper virtual machine.
3. Specify the IP address, subnet mask, default gateway, and the preferred DNS server address. Optionally, type an alternative DNS server address.
   - Verify that the IP address that you specify for the Helper virtual machine is not already in use on the network.
4. (Optional) On the **DNS** tab, create a priority list of DNS suffixes to use when resolving unqualified domain names.
   - The DNS suffix with highest priority is appended to the unqualified domain name.
5. To save your settings, select another option from the options list or click **Next**.

vCenter Converter uses the IP address and DNS server that you specify to copy data from the source Linux machine to the helper virtual machine during conversion.

Configure the Software of the Destination Virtual Machine

You can configure the guest operating system so that it is ready to operate in a virtual environment.

Software configuration includes a number of settings.

- **Customize the Windows Guest Operating System** on page 49
  - You can customize guest operating systems running Windows XP or later so that the virtual machine is prepared to work immediately in the destination environment.
- **Install VMware Tools on the Destination Virtual Machine** on page 52
  Install VMware Tools to improve graphics performance of the guest operating system. Other enhancements include automatic grab and release of the pointer between applications, copying and pasting between guest and host, improved mouse performance, and so on.

- **Remove System Restore Checkpoints** on page 52
  When you import source machines running Windows XP or later, you should remove all System Restore checkpoints to speed up the conversion process.

- **Update the Device Drivers on the Destination Virtual Machine** on page 53
  You must reconfigure the destination virtual machine to allow it to start properly.

### Customize the Windows Guest Operating System

You can customize guest operating systems running Windows XP or later so that the virtual machine is prepared to work immediately in the destination environment.

**Prerequisites**

Save the Sysprep files to `%ALLUSERSPROFILE%\Application Data\VMware\VMware vCenter Converter\sysprep` on the machine that runs vCenter Converter server. For more details on the sysprep files location for different operating systems, see “Save Sysprep Files,” on page 78.

On the Options page of the Import Machine wizard, click **Advanced options**, select **Customize guest preferences for the virtual machine** and click **Next** to view and adjust the available customization options.

- **Customize the Identity of the Destination Virtual Machine** on page 49
  To identify the destination virtual machine with the destination network, personalize it by editing its name, owner, and organization name, and by generating a new security ID.

- **Enter the Windows License Information** on page 50
  Ensure that you enter licensing information for all destination virtual machines running guest operating systems that are subject to licensing.

- **Set the Time Zone** on page 51
  You can set the time zone if you are converting a virtual machine to use in a different time zone.

- **Configure the Network Adapters** on page 51
  You can configure the network settings of the virtual machine to work with the network configuration of the destination environment.

- **Assign a Workgroup or Domain Details** on page 51
  You can set up the workgroup and the domain in which the destination virtual machine participates.

### Customize the Identity of the Destination Virtual Machine

To identify the destination virtual machine with the destination network, personalize it by editing its name, owner, and organization name, and by generating a new security ID.

**Prerequisites**

On the Options page of the Import Machine wizard, click **Advanced options**, select **Customize guest preferences for the virtual machine** and click **Next** to view and adjust the available customization options.
Procedure

1. On the Customizations page, select **Computer information** from the options list.
2. Customize the guest operating system identity.
   a. In the **Computer Name** text box, specify a computer name to identify the virtual machine on the network.
      Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but vCenter Converter permits it. The computer name cannot contain more than 15 characters or consist only of numerals.
   b. In the **Owner Name** text box, write the name of the owner of the virtual machine.
      Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but vCenter Converter permits it. The owner name cannot have more than 63 characters or consist only of numerals.
   c. In the **Organization** field, enter an organization name.
      Valid characters include all printable characters. The limit is 63 characters.
3. (Optional) To create a new security identifier, select **Generate New Security ID (SID)**.
   By default, the security ID is selected for Windows Vista systems and Longhorn sources and cannot be deselected.
4. To save your settings, select another option from the options list or click **Next**.

The identifiers of the destination virtual machine are assigned according to your settings.

**Enter the Windows License Information**

Ensure that you enter licensing information for all destination virtual machines running guest operating systems that are subject to licensing.

**Prerequisites**

On the Options page of the Import Machine wizard, click **Advanced options**, select **Customize guest preferences for the virtual machine** and click **Next** to view and adjust the available customization options.

**Procedure**

1. On the Customizations page, select **Windows license** from the options list.
2. Enter **Product ID** information for the destination virtual machine.
3. (Optional) Select **Include server license information** if the guest operating system is Microsoft Windows Server 2003 or Microsoft Windows Server 2008.
4. Select a **Server license mode** option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Per seat</td>
<td>For individual user licenses.</td>
</tr>
<tr>
<td>Per server</td>
<td>For a concurrent user license. Specify the Maximum connections value when you select this option.</td>
</tr>
</tbody>
</table>

5. To save your settings, select another option from the options list or click **Next**.

The Windows license information is saved to the destination virtual machine after the conversion.
Set the Time Zone

You can set the time zone if you are converting a virtual machine to use in a different time zone.

Prerequisites

On the Options page of the Import Machine wizard, click Advanced options, select Customize guest preferences for the virtual machine and click Next to view and adjust the available customization options.

Procedure

1. On the Customizations page, select Time zone from the options list.
2. Select the target time zone from the Time zone drop-down menu.
3. To save your settings, select another option from the options list or click Next.

The time zone is set on the destination virtual machine after the conversion.

Configure the Network Adapters

You can configure the network settings of the virtual machine to work with the network configuration of the destination environment.

The option for configuring network adapters is available for all supported destinations.

Prerequisites

On the Options page of the Import Machine wizard, click Advanced options, select Customize guest preferences for the virtual machine and click Next to view and adjust the available customization options.

Procedure

1. On the Customizations page, select Network interface settings from the options list.
2. Select a network adapter and click Customize to configure its properties.
   a. On the General tab, manually enter the IP address and DNS server address.
   b. On the DNS tab, specify the DNS connections by entering DNS suffixes.
   c. Enter a DNS suffix and click Add.
      You can add more than one DNS suffix.
   d. If you are entering multiple DNS suffixes, use Move up and Move down to specify the order in which the guest operating system uses the connections.
   e. On the WINS tab, type the primary and secondary WINS IP address in the text box.
3. To save your settings, select another option from the options list or click Next.

When powered on, the destination virtual machine uses the network settings that you configured.

Assign a Workgroup or Domain Details

You can set up the workgroup and the domain in which the destination virtual machine participates.

Prerequisites

On the Options page of the Import Machine wizard, click Advanced options, select Customize guest preferences for the virtual machine and click Next to view and adjust the available customization options.
Procedure

1. On the Customizations page, select **Workgroup/Domain** from the options list.

2. Select how the virtual machine participates in the destination network.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Workgroup</strong></td>
<td>Valid characters include A-Z, a-z, 0-9, space, and the hyphen (-). Maximum length is 15 characters.</td>
</tr>
<tr>
<td><strong>Windows server domain</strong></td>
<td>The text box must have a value. Valid characters include A-Z, a-z, 0-9, space, period , and hyphen (-). Each label delineated by a period can be 63 characters. The entire text string can be up to 254 characters. User credentials are required.</td>
</tr>
</tbody>
</table>

3. To save your settings, select another option from the options list or click **Next**.

The destination virtual machine connects to the workgroup and domain server you specified.

**Install VMware Tools on the Destination Virtual Machine**

Install VMware Tools to improve graphics performance of the guest operating system. Other enhancements include automatic grab and release of the pointer between applications, copying and pasting between guest and host, improved mouse performance, and so on.

Procedure

1. On the Options page of the Import Machine wizard, click **Advanced options**.

2. Select the **Install VMware Tools on the destination virtual machine** check box.

3. To save your settings, select another option from the options list or click **Next**.

vCenter Converter installs VMware Tools on the destination machine during conversion.

**Remove System Restore Checkpoints**

When you import source machines running Windows XP or later, you should remove all System Restore checkpoints to speed up the conversion process.

System Restore is enabled on Windows Vista and Windows XP systems by default. For Windows Vista, if you are performing volume-based file-level cloning, System Restore checkpoints are automatically removed from the destination virtual machine, regardless of whether the **Remove System Restore checkpoints on destination** check box is selected or deselected. If you are performing disk-based cloning or volume-based block-level cloning, deselecting the check box instructs vCenter Converter to keep the System Restore check points in the destination virtual machine.

Removing all System Restore checkpoints prevents the target machine from reverting to a preconversion state. Restoring a checkpoint in the target virtual machine that was created before you cloned the source machine can damage the system and cause the target virtual machine to become unbootable.

Procedure

1. On the Options page of the Import Machine wizard, click **Advanced options**.

2. Select the **Remove System Restore checkpoints on destination** check box.

3. To save your settings, select another option from the options list or click **Next**.
Update the Device Drivers on the Destination Virtual Machine

You must reconfigure the destination virtual machine to allow it to start properly.

After the import of physical machine sources, certain device drivers must be updated to allow the destination virtual machine to boot in a virtual environment. For other source machines, some drivers must be disabled to allow the destination virtual machine to operate. If the operating system on the source machine is not on the default drive, the boot.ini or the BCD must be updated so the destination virtual machine can start.

Procedure
1  On the Options page of the Import Machine wizard, click **Advanced options**.
2  Select the **Reconfigure destination virtual machine** check box.

vCenter Converter updates the device drivers on the destination virtual machine so it can work with virtual hardware.

Configure the Import Task

You can configure the conversion process and select the behavior of the source and destination machine during and after conversion. You can change the status of the source and destination services only when the source machine is running a Windows operating system.

- **Set the Starting Mode of the Destination Services** on page 54
  To minimize downtime of a Windows service, you can select the service and have it start automatically on the destination virtual machine. You can also prevent Windows services from automatically starting on the destination machine.

- **Stop Services Running on the Source Machine** on page 54
  You can make sure that you do not lose data from services running on the source machine. You can select which services to stop before vCenter Converter synchronizes the data between the source and destination machine. As a result, the services do not generate data while source and destination machines are synchronized.

- **Synchronize the Destination Machine with Changes from the Source Machine** on page 55
  Importing a powered-on Windows machine means that vCenter Converter copies data from the source machine to the destination machine while the source machine is still running and generating changes. This process is the first transfer of data. You can transfer data for the second time by copying only the changes made during the first transfer of data. This process is called synchronization.

- **Power Off the Source Machine After the Import** on page 55
  If your source machine is running services that you want to start on the destination virtual machine after import, you can power off the source machine to avoid interference between source and destination services.

- **Power On the Destination Virtual Machine After the Import** on page 55
  You can minimize the downtime of important services by powering on the destination virtual machine immediately when the import is complete.
Limit the Amount of Resources Used by the Import Task on page 55

A conversion task competes for computing resources with other processes. To limit the impact of the conversion task on other workloads, you can throttle it. If you do not modify task throttling, conversion tasks are carried out with normal priority and depending on the available computing resources during conversion.

Uninstall vCenter Converter Agent from the Source Machine on page 56

After the import task of a Windows powered-on machine is completed, you can uninstall the vCenter Converter agent from the source machine.

Set the Starting Mode of the Destination Services

To minimize downtime of a Windows service, you can select the service and have it start automatically on the destination virtual machine. You can also prevent Windows services from automatically starting on the destination machine.

Setting the destination services is available only when you import source machines that run Windows.

Procedure

1. On the Options page of the Import Machine wizard, select Services from the options list.
2. (Optional) If you are importing a powered-on source machine, click the Destination services tab.
   You do not have to select a tab if the source machine is powered-off.
3. In the Startup mode column, select the starting mode for a service.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>The service starts automatically after the destination machine is powered on.</td>
</tr>
<tr>
<td>Manual</td>
<td>The service does not start after the destination machine is powered on, but you can start it manually.</td>
</tr>
<tr>
<td>Disabled</td>
<td>The service is disabled and does not start after the destination machine is powered on.</td>
</tr>
</tbody>
</table>

4. To save your settings, select another option from the options list or click Next.

Stop Services Running on the Source Machine

You can make sure that you do not lose data from services running on the source machine. You can select which services to stop before vCenter Converter synchronizes the data between the source and destination machine. As a result, the services do not generate data while source and destination machines are synchronized.

Stop services in combination with synchronization to prevent data loss during the synchronization process.

Stopping services is available only when you import a powered-on Windows machine.

Procedure

1. On the Options page of the Import Machine wizard, select Services from the options list.
2. Click the Source services tab.
3. To stop a service on the source machine before synchronization, highlight a service and select the Stop check box to the right.
4. To save your settings, select another option from the options list or click Next.

vCenter Converter stops the source services you selected before it synchronizes the destination machine with the source machine.
Synchronize the Destination Machine with Changes from the Source Machine

Importing a powered-on Windows machine means that vCenter Converter copies data from the source machine to the destination machine while the source machine is still running and generating changes. This process is the first transfer of data. You can transfer data for the second time by copying only the changes made during the first transfer of data. This process is called synchronization.

Synchronization is available only for Windows XP or later source operating systems.

If you resize FAT volumes or shrink NTFS volumes, you cannot use the synchronization option.

**Prerequisites**

Stop various source services to make sure they do not generate additional changes during the synchronization, which could lead to data loss.

**Procedure**

1. On the Options page of the Import Machine wizard, click **Advanced options**.
2. Select the **Synchronize changes that occur to the source during cloning** check box.
3. To save your settings, select another option from the options list or click **Next**.

vCenter Converter synchronizes the destination machine with the source machine.

Power Off the Source Machine After the Import

If your source machine is running services that you want to start on the destination virtual machine after import, you can power off the source machine to avoid interference between source and destination services.

**Procedure**

1. On the Options page, click **Advanced options** from the options list.
2. In the **Post-conversion power state** panel, select **Power off source machine**.

vCenter Converter powers off the source machine after the import is complete.

Power On the Destination Virtual Machine After the Import

You can minimize the downtime of important services by powering on the destination virtual machine immediately when the import is complete.

**Procedure**

1. On the Options page of the Import Machine wizard, click **Advanced options**.
2. In the **Post-conversion power state** panel, select **Power on destination machine**.

After the import, vCenter Converter powers on the destination machine.

Limit the Amount of Resources Used by the Import Task

A conversion task competes for computing resources with other processes. To limit the impact of the conversion task on other workloads, you can throttle it. If you do not modify task throttling, conversion tasks are carried out with normal priority and depending on the available computing resources during conversion.

A powered-on source machine runs its own conversion task. You can limit the impact of the conversion task on other workloads running on the powered-on machine.

For source machines different from powered-on machines, you can limit the resources used on the machine where vCenter Converter server is installed.
Throttling controls the CPU and network resources that the conversion process uses. You cannot throttle disk I/O from the vCenter Converter interface, but can throttle it indirectly by throttling the network.

**Procedure**

1. On the Options page of the Import Machine wizard, select **Throttling** from the options list.
2. From the **CPU throttling** drop-down menu, select the priority of the conversion task.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>The priority of the current conversion task is set to normal.</td>
</tr>
<tr>
<td>Light</td>
<td>The priority of the current conversion task is reduced slightly below normal.</td>
</tr>
<tr>
<td>Medium</td>
<td>The priority of the current conversion task is set to lowest.</td>
</tr>
</tbody>
</table>

*Note*: vCenter Converter reduces the thread priorities of conversion tasks to control the CPU resources they consume.

3. Select **Network bandwidth throttling** to be able to select maximum network bandwidth.
4. In the network bandwidth spin-box, select the maximum network bandwidth at which vCenter Converter performs the conversion task.
5. To save your settings, select another option from the options list or click **Next**.

**Uninstall vCenter Converter Agent from the Source Machine**

After the import task of a Windows powered-on machine is completed, you can uninstall the vCenter Converter agent from the source machine.

**Procedure**

1. In Windows, run the **Add or Remove Programs** utility.
2. From the list of installed programs, locate and click **vCenter Converter Agent**.
3. Click **Remove**.
4. In the confirmation dialog box, click **Yes**.

**Schedule the Import Task**

You can set the time at which you want an import task to start.

**Prerequisites**

You must start the Import Machine wizard as a scheduled task. For example, in the vSphere Client, select **File > New > Scheduled Task...** and select **Import a machine** from the drop-down menu.
Procedure

1. Complete the Import Machine wizard until you reach the Schedule Task page.

2. On the Schedule Task page, configure the scheduled task.
   
   Make sure you give a detailed name and description to the task so that you can recognize it later among other scheduled tasks.
   
   a. In the Task name text box, type a name for the scheduled task.
   
   b. (Optional) In the Task description text box, type a description.
   
   c. From the Start date drop-down menu, select a date for the scheduled task.
   
   d. Use the Start time spin box to schedule the time at which the scheduled task starts.

3. Click Next to view a summary of the scheduled task.

After you complete the Import Machine wizard and submit the task, the import is scheduled for the specified time and is added to the vCenter Server list of scheduled tasks. If the scheduled time is the current time or a time in the past, the import task starts immediately.

Review the Summary and Submit the Import Task

On the Summary page, you can view a summary of the new conversion task before you add it to the task list.

The summary includes information about the source machine, the destination virtual machine, destination customization settings (if any), and scheduled time (if any). vCenter Converter performs task validation at this stage.

Prerequisites

You must complete all task configuration steps to access the Summary page.

Procedure

1. Complete all the steps before the Summary page.
   
   a. If you selected to customize the Windows guest operating system, click Next on the Customizations page.
   
   b. If you started the Import Machine wizard as a scheduled task, click Next on the Schedule task page.
   
   c. If you did not select to create a scheduled task or customize the Windows guest operating system, click Next on the Options page.

2. Review the summary of the task.

3. Click Finish to submit the task.

   vCenter Converter validates the task parameters. This might take several minutes. If the task validation is successful, the task appears in the Recent Tasks list in vSphere Client. If the task validation fails, click Back and correct the invalid parameters.
Export vCenter Server Machines

You can use vCenter Converter to export virtual machines from the vCenter Server Inventory to managed (ESX/ESXi or vCenter Server) formats or hosted (VMware Workstation, VMware Fusion, VMware Player, VMware Server, and VMware ACE) formats.

Procedure

1. **Start the Export Virtual Machine Wizard** on page 60
   You use the Export Virtual Machine wizard to enter information about the source and destination machine and select the task parameters for the conversion. The wizard is context sensitive. You must complete the steps in the wizard to start an export task.

2. **Select a Virtual Machine to Export** on page 60
   You should select the virtual machine to export before you start the Export Virtual Machine wizard. However, if you start the wizard by creating a scheduled task, the wizard asks you to select the source virtual machine.

3. **Select a Destination for the New Virtual Machine** on page 61
   You must select a destination for the virtual machine you export.

4. **Configure the Hardware of the Destination Virtual Machine** on page 63
   You can configure the virtual hardware resources that the destination virtual machine uses.

5. **Configure the Software of the Destination Virtual Machine** on page 69
   You can configure the guest operating system so that it is ready to operate in a virtual environment.

6. **Configure the Export Task** on page 74
   You can configure the conversion process and select the behavior of the source and destination machine during and after conversion. You can change the status of the source and destination services only when the source machine is running a Windows operating system.

7. **Schedule the Export Task** on page 75
   You can set the time at which you want an export task to start.

8. **Review the Summary and Submit the Export Task** on page 76
   On the Summary page, you can view a summary of the new conversion task before you add it to the task list.
Start the Export Virtual Machine Wizard

You use the Export Virtual Machine wizard to enter information about the source and destination machine and select the task parameters for the conversion. The wizard is context sensitive. You must complete the steps in the wizard to start an export task.

The information you must provide depends on the location from which you start the wizard. For example, if you start the Export Virtual Machine by right-clicking a virtual machine, the wizard does not prompt you to select a source machine. If you start the wizard from the Scheduled Tasks view, the wizard asks you to select a source machine.

Prerequisites

The virtual machine you export must be powered-off.

Procedure

1. Go to Start > Programs > VMware > VMware Client.
2. Type the host name or IP address of the vCenter Server associated with vCenter Converter.
3. Type an appropriate Windows domain user name and password and click Login.
   You can start the wizard in several ways.
   - Select a powered-off virtual machine from the vSphere Client Inventory, select Inventory > Virtual Machine > Export.
   - Right-click a virtual machine in any view and select Export.
   - In the Scheduled Tasks view, select File > New > Scheduled Task, and in the drop-down menu, select Export a virtual machine and click OK.
   - In the Recent Tasks or Scheduled Tasks list, right-click an export task and select Copy As New.
5. Complete the wizard to add the export task to the task list.

What to do next

If you selected to schedule an export task, you must select a virtual machine to export. If you started the Export Virtual Machine wizard by right-clicking a virtual machine, you can configure the destination location.

Select a Virtual Machine to Export

You should select the virtual machine to export before you start the Export Virtual Machine wizard. However, if you start the wizard by creating a scheduled task, the wizard asks you to select the source virtual machine.

Prerequisites

You must select a powered-off machine to export.

Procedure

- If you right-clicked a powered-off virtual machine from the Inventory and selected Export, click Next on the Export Virtual Machine page.
- If you started the Export Virtual Machine wizard as a scheduled task, select a powered-off virtual machine to export and click Next.

What to do next

You can now select a destination for the new virtual machine.
Select a Destination for the New Virtual Machine

You must select a destination for the virtual machine you export.

You can export your source machine to managed or hosted destinations.

Select a Managed Destination

You can export a virtual machine to use with ESX/ESXi or with an ESX/ESXi host that vCenter Server manages.

Procedure

1. On the Destination System page, select VMware Infrastructure virtual machine from the Select destination type drop-down menu.
2. Provide the IP address or host name and credentials for authentication with the ESX host or the vCenter Server.
3. Click Next.

The Destination Location page appears.

What to do next

You can now configure the managed destination for the exported virtual machine.

Configure the Managed Destination

You can customize the location settings for the destination virtual machine. The settings include selecting an ESX host, a resource pool, or a cluster, naming the virtual machine, selecting a datastore, and selecting a virtual machine hardware version.

Procedure

1. On the Destination Location page, select a datacenter object from the inventory to accommodate the destination virtual machine.
   - Select an ESX host.
   - Select a resource pool.
   - Select a cluster.
2. If the cluster you selected is not automated, you can select an ESX host that belongs to the selected cluster from the Host drop-down menu.
3. In the Virtual machine name text box, enter a name for the destination virtual machine.
4. Select a datastore from the Datastore drop-down menu.
   The selected datastore stores the virtual machine files.
5 (Optional) Select the virtual hardware version for the destination virtual machine from the **Virtual machine version** drop-down menu.

The **Virtual machine version** drop-down menu is available only when you select a vCenter Server 4.0 or 4.1 as a destination. The menu does not appear when you select a fully automated cluster or an ESX 3.x host from the Inventory.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version 4</td>
<td>Select when sharing storage or virtual machines with ESX 3.x versions.</td>
</tr>
<tr>
<td>Version 7</td>
<td>Select if you want to install the latest virtual machine features. This hardware version is not supported for ESX 3.x versions.</td>
</tr>
</tbody>
</table>

6 Click **Next**.

The managed destination settings are now configured.

**What to do next**

You can now configure the hardware and software of the destination virtual machine.

**Select a Virtual Machine Folder**

If you use folders in your virtual environment to manage groups of virtual machines, you can select a folder to accommodate the destination virtual machine.

**Prerequisites**

You must use vCenter Server as a destination to be able to select a virtual machine folder.

You must have a virtual machine folder in the destination vCenter Server to store the destination virtual machine.

**Procedure**

1 On the Options page, select **Destination attributes** from the options list.
2 Select a folder from the folder list in the right panel.
3 To save your settings, select another option from the options list or click **Next**.

After the conversion, the destination virtual machine is located in the selected virtual machine folder.

**Select a Hosted Destination**

You can export a virtual machine for use with Workstation, VMware Fusion, VMware Server, or VMware Player.

**Procedure**

1 On the Destination System page, select **VMware Workstation or other VMware virtual machine** from the **Select destination type** drop-down menu.
2 Select the destination VMware hosted product from the **Select VMware product** drop-down menu.
3 Provide a name for the destination virtual machine in the **Name** text box.
4 Provide a valid network path to a directory where the destination virtual machine files will be exported. The network path to the directory must be accessible by the vCenter Converter server machine. For example, `\server\virtual_machines\`
5 Provide a valid user name and password in the text boxes for entering credentials.
6 Click **Next**.
What to do next

On the Customization page, you can select configuration options for the guest operating system.

Configure the Hardware of the Destination Virtual Machine

You can configure the virtual hardware resources that the destination virtual machine uses.

Copy Disks or Volumes

You can copy all disks to the destination or select which volumes to be copied and which to be excluded. vCenter Converter supports disk-based and volume-based cloning.

Procedure

On the Options page of the Export Virtual Machine wizard, select a copy mode from the **Data copy type** drop-down menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy all disks and maintain layout</td>
<td>Performs disk-based cloning. You can preserve the source disk layout in the destination virtual machine.</td>
</tr>
<tr>
<td>Select volumes to copy</td>
<td>Performs volume-based cloning. You can select which volumes to copy to the destination virtual machine. You can also resize and reorganize the volume layout.</td>
</tr>
</tbody>
</table>

**NOTE** The options available depend on your source and destination selection.

The Data to copy options change as you select a different option.

Resize a Volume

To manage disk space on the destination datastore, you can resize the disk volumes before you begin the conversion.

Procedure

1. On the Options page of the Export Virtual Machine wizard, select **Data to copy** from the options list.
2. From the **Data copy type** drop-down menu, select **Select volumes to copy**.
3. In the Destination size column, select an option to specify the size of a destination volume.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain size</td>
<td>Maintains the original source volume size.</td>
</tr>
<tr>
<td>Min size</td>
<td>Copies only the used space of the source volume.</td>
</tr>
<tr>
<td>Type size in GB</td>
<td>Allows you to type a custom size in GB for the destination volume. The value cannot be smaller than the used space on the source volume, but can be larger than its total size. The maximum allowed disk size is 999GB. The volume size can be as large as the disk size, depending on your configuration.</td>
</tr>
<tr>
<td>Type size in MB</td>
<td>Allows you to type a custom size in MB for the destination volume. The value cannot be smaller than the used space on the source volume, but can be larger than its total size. The maximum allowed disk size is 999GB. The volume size can be as large as the disk size, depending on your configuration.</td>
</tr>
</tbody>
</table>

4. To save your settings, select another option from the options list or click **Next**.
Delete a Volume

You can choose to delete a volume from the destination virtual machine. During the conversion process, vCenter Converter ignores the deselected volumes and copies only the volumes that are selected.

You cannot delete the system volume from the destination virtual machine. For example, if C: is the volume that contains the Windows operating system installation, you cannot remove it from the destination virtual machine.

Prerequisites

The source virtual machine must have more than one volume to be able to deselect existing volumes.

Procedure

1. On the Options page of the Export Virtual Machine wizard, select Data to copy from the options list.
2. From the Data copy type drop-down menu, select Select volumes to copy.
3. Deselect the volumes that you do not want to copy to the destination virtual machine.
4. To save your settings, select another option from the options list or click Next.

The deselected volumes are ignored during the conversion process.

Move a Volume to a Different Datastore

You can store a disk volume in a datastore different from the one that accommodates the virtual machine configuration file (.vmx).

Prerequisites

You must select a managed destination with more than one datastore.

Procedure

1. On the Options page of the Export Virtual Machine wizard, select Data to copy from the options list.
2. From the Data copy type drop-down menu, select Select volumes to copy.
3. Click Advanced and select the Destination layout tab.
4. Select a volume from the list and click Add disk.
   vCenter Converter creates a new virtual disk.
5. Select a volume and use the Move up and Move down buttons to accommodate the volume in the new virtual disk.
   If you leave the new virtual disk empty, vCenter Converter does not create the new virtual disk on the destination virtual machine.
6. Highlight the new virtual disk and select a different datastore from the Destination datastore drop-down menu.
7. To save your settings, select another option from the options list or click Next.

The virtual disk file (.vmdk) that contains the volume is stored in the selected datastore.

Move a Volume to a Different Virtual Disk

You can add a virtual disk to the destination virtual machine and accommodate a volume in the new disk.

The number of virtual disks depends on the number of volumes that exist on the source virtual machine. For example, if you have only one volume on the source virtual machine, you cannot add a virtual disk to the destination virtual machine.
You cannot move the system volume where the guest operating system is installed. For example, if your Windows operating system is installed on C:, you cannot move the C: volume.

Procedure
1. On the Options page of the Export Virtual Machine wizard, select **Data to copy** from the options list.
2. From the **Data copy type** drop-down menu, select **Select volumes to copy**.
3. Click **Advanced** and select the **Destination layout** tab.
4. Select a volume from the list and click **Add disk**.
   - vCenter Converter creates a new virtual disk.
5. Select a volume and use the **Move up** and **Move down** buttons to accommodate the volume in the new virtual disk.
   - If you leave the new virtual disk empty, vCenter Converter does not create the new virtual disk on the destination virtual machine.
6. To save your settings, select another option from the options list or click **Next**.
   - The volume is moved to the new virtual disk.

Add a Virtual Disk
You can add a virtual disk to the destination virtual machine.

The number of virtual disks depends on the number of volumes that exist on the source virtual machine. For example, if you have only one volume on the source virtual machine, you cannot add a virtual disk to the destination virtual machine.

Prerequisites
You must have more than one volumes on the source machine to add an additional virtual disk.

Procedure
1. On the Options page of the Export Virtual Machine wizard, select **Data to copy** from the options list.
2. From the **Data copy type** drop-down menu, select **Select volumes to copy**.
3. Click **Advanced** and select the **Destination layout** tab.
4. Select a volume from the list and click **Add disk**.
   - If you leave the new virtual disk empty, vCenter Converter does not create the new virtual disk on the destination virtual machine. You must move at least one volume to the new virtual disk.
5. To save your settings, select another option from the options list or click **Next**.
   - The new virtual disk is created on the destination datastore.

Move a Disk to a Different Datastore
You can store the destination virtual disks in separate datastores.

Prerequisites
You must select a managed destination with more than one datastore.

Use disk-based cloning to select a different datastore for a virtual disk.
**Procedure**

1. On the Options page of the Export Virtual Machine wizard, select **Data to copy** from the options list.

2. From the **Data copy type** drop-down menu, select **Copy all disks and maintain layout**.

3. Highlight a virtual disk to relocate and select a different datastore from the **Destination datastore** drop-down menu.

4. To save your settings, select another option from the options list or click **Next**.

The virtual disk file (.vmdk) is stored in the selected datastore.

**Create an Expandable Disk on a Managed Destination**

To save space on the destination datastore, you can copy only the existing data from a source virtual disk and create an expandable disk on the destination. Later, as you use the destination virtual machine and write new data, the destination virtual disk grows.

You can create an expandable disk by using volume-based and disk-based cloning.

**Procedure**

1. On the Options page of the Export Virtual Machine wizard, select **Data to copy** from the options list.

2. Use disk-based cloning to create an expandable disk.
   a. From the **Data copy type** drop-down menu, select **Copy all disks and maintain layout**.
   b. Highlight a virtual disk and select **Thin** from the **Type** drop-down menu.

3. Use volume-based cloning to create an expandable disk.
   a. From the **Data copy type** drop-down menu, select **Select volumes to copy** and click **Advanced**.
   b. Select the **Destination layout** tab, highlight a virtual disk, and select **Thin** from the **Type** drop-down menu.

4. To save your settings, select another option from the options list or click **Next**.

vCenter Converter copies only the existing data to the destination datastore. The empty disk space from the virtual disk is not copied to the datastore. As you use the destination virtual machine and write new data to the disk, the size of the destination disk grows.

**Create an Expandable Disk on a Hosted Destination**

To save space on the destination, you can copy only the existing data from a source virtual disk. Later, as you use the destination virtual machine and write new data, the destination virtual disk grows.

You can create an expandable disk by using volume-based and disk-based cloning.

**Prerequisites**

You must select a hosted destination, such as VMware Workstation, to use the **Not pre-allocated** disk option.

**Procedure**

1. On the Options page of the Export Virtual Machine wizard, select **Data to copy** from the options list.

2. Use disk-based cloning to create an expandable disk.
   a. From the **Data copy type** drop-down menu, select **Copy all disks and maintain layout**.
   b. From the **Type** drop-down menu, select **Not pre-allocated**.
3 Use volume-based cloning to create an expandable disk.
   a From the Data copy type drop-down menu, select Select volumes to copy and click Advanced.
   b Select the Destination layout tab, select a virtual disk, and select Not pre-allocated from the Type drop-down menu.

4 To save your settings, select another option from the options list or click Next.

vCenter Converter copies only the existing data to the destination datastore. The empty disk space from the virtual disk is not copied to the datastore. As you use the destination virtual machine and write new data to the disk, the size of the destination disk grows.

### Split a Disk Into 2GB Virtual Disk Files

You can split a disk from the source machine into 2GB virtual disk files on the destination virtual machine.

**Prerequisites**

On the Destination System page, you must select a hosted destination virtual machine, such as a VMware Workstation virtual machine.

**Procedure**

1 On the Options page of the Export Virtual Machine wizard, select Data to copy from the options list.

2 Use disk-based or volume-based cloning to split a disk into 2GB files.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use disk-based cloning</td>
<td>From the Data copy type drop-down menu, select Copy all disks and maintain layout.</td>
</tr>
</tbody>
</table>
| Use volume-based cloning| a From the Data copy type drop-down menu, select Select volumes to copy and click Advanced.  
   b Select the Destination layout tab. |

3 From the Type drop-down menu, select whether to use pre-allocated disk space.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2GB Split pre-allocated</td>
<td>Splits the source disk into 2GB sections on the destination.</td>
</tr>
<tr>
<td>2GB Split not pre-allocated</td>
<td>Creates 2GB sections on the destination that include only the real used space on the source disk. As the destination disk grows, new 2GB sections are created to accommodate the new data until the original source disk size is reached.</td>
</tr>
</tbody>
</table>

4 To save your settings, select another option from the options list or click Next.

vCenter Converter copies the original disks as 2GB .vmdk virtual disk files to the destination system.

### Delete a Disk

You can select a disk from the source machine and delete it from the disk layout of the destination virtual machine.

**Prerequisites**

The source machine must have more than one hard disk.

**Procedure**

1 On the Options page of the Export Virtual Machine wizard, select Data to copy from the options list.

2 From the Data copy type drop-down menu, select Select volumes to copy.
3 Click Advanced and select the Destination layout tab.
4 Delete the disk.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preserve the volumes associated with the disk</td>
<td>a  Click Advanced and select the Destination layout tab.</td>
</tr>
<tr>
<td></td>
<td>b  Move the volumes from the disk you want to delete to another virtual disks.</td>
</tr>
<tr>
<td></td>
<td>c  Highlight the empty disk and click Remove disk.</td>
</tr>
<tr>
<td>Delete the volumes associated with the disk</td>
<td>a  Click Advanced and select the Source volumes tab.</td>
</tr>
<tr>
<td></td>
<td>b  Deselect the volumes associated with the disk that you want to delete.</td>
</tr>
</tbody>
</table>

5 To save your settings, select another option from the options list or click Next.

vCenter Converter creates .vmdk files in the destination datastore only for the virtual disks you selected to preserve.

**Copy All Disks to the Destination**

To preserve the source disks on the destination virtual machine, you can copy all disks to the destination.

**Procedure**

1 On the Options page of the Export Virtual Machine wizard, select Data to copy from the options list.
2 From the Data copy type drop-down menu, select Copy all disks and maintain layout.
3 (Optional) If the destination datastore is low on disk space, highlight a virtual disk and select a different datastore from the Destination datastore drop-down menu.

**NOTE** You must have more than one datastore to move a disk to a different datastore.

4 To save your settings, select another option from the options list or click Next.

vCenter Converter copies the disks to the selected datastores and preserves the source disk layout.

**Edit the Number of Processors**

You can change the number of processors that the destination virtual machine uses.

**Prerequisites**

Make sure the destination host and the guest operating system support the number of processors you assign to the destination virtual machine.

**Procedure**

1 On the Options page of the Export Virtual Machine wizard, select Devices from the options list.
2 From the Number of processors drop-down menu, select the processor count for the destination virtual machine.
3 To save your settings, select another option from the options list or click Next.

The destination virtual machine is configured with the number of processors that you selected. If vCenter Converter shows a message that the destination hardware does not support the number of processors you selected, you must select a supported number of processors.
Allocate Memory for the Destination Virtual Machine

You can change the amount of memory allocated to the destination virtual machine.

By default, vCenter Converter recognizes the amount of memory on the source machine and allocates it to the destination virtual machine.

Procedure

1. On the Options page of the Export Virtual Machine wizard, select Devices from the options list.
2. In the Memory panel, use the slider or the spin-box to specify the amount of memory for the destination virtual machine.
3. To save your settings, select another option from the options list or click Next.

vCenter Converter validates the memory amount. A warning appears if you set the memory amount to more than the maximum supported or to less than the required minimum.

Specify a Disk Controller for the Destination Virtual Machine

You can select a disk controller type for the destination virtual disks.

Procedure

1. On the Options page of the Export Virtual Machine wizard, select Devices from the options list.
2. From the Disk controller drop-down menu, select a disk controller for the destination virtual disk.
   
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCSI Bus Logic</td>
<td>Use SCSI virtual disks in the destination virtual machine.</td>
</tr>
<tr>
<td>IDE</td>
<td>Use IDE virtual disks in the destination virtual machine.</td>
</tr>
<tr>
<td>Preserve source</td>
<td>Use the same type of disk controllers that are installed on the source machine.</td>
</tr>
</tbody>
</table>

3. To save your settings, select another option from the options list or click Next.

Configure the Network Settings of the Destination Virtual Machine

You can change the number of network adapters and set the network that the destination virtual machine uses. You can also set network adapters to connect to the network when the destination virtual machine powers on.

Procedure

1. On the Options page of the Export Virtual Machine wizard, select Networks from the options list.
2. From the Network adapters to connect drop-down menu, select the number of network adapters to be used by the destination virtual machine.
3. Use the Network drop-down menu to select the network the adapter connects to.
4. To connect an adapter when you power on the destination virtual machine, select the Connect at power-on check box.
5. To save your settings, select another option from the options list or click Next.

Configure the Software of the Destination Virtual Machine

You can configure the guest operating system so that it is ready to operate in a virtual environment.
Software configuration includes a number of settings.
Customize the Windows Guest Operating System

You can customize guest operating systems running Windows XP or later so that the virtual machine is prepared to work immediately in the destination environment.

Prerequisites

Save the Sysprep files to %ALLUSERSPROFILE%\Application Data\VMware\VMware vCenter Converter\sysprep on the machine that runs vCenter Converter server. For more details on the sysprep files location for different operating systems, see “Save Sysprep Files,” on page 78.

On the Options page of the Export Virtual Machine wizard, click Advanced options, select Customize guest preferences for the virtual machine, and click Next to view and adjust the available customization options.

Customize the Identity of the Destination Virtual Machine

To identify the destination virtual machine with the destination network, personalize it by editing its name, owner, and organization name, and by generating a new security ID.

Prerequisites

On the Options page of the Export Virtual Machine wizard, click Advanced options, select Customize guest preferences for the virtual machine, and click Next to view and adjust the available customization options.

Procedure

1. On the Customizations page, select Computer information from the options list.
2. Customize the guest operating system identity.
   a. In the Computer Name text box, specify a computer name to identify the virtual machine on the network.
      Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but vCenter Converter permits it. The computer name cannot contain more than 15 characters or consist only of numerals.
   b. In the Owner Name text box, write the name of the owner of the virtual machine.
      Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but vCenter Converter permits it. The owner name cannot have more than 63 characters or consist only of numerals.
   c. In the Organization field, enter an organization name.
      Valid characters include all printable characters. The limit is 63 characters.
3. (Optional) To create a new security identifier, select Generate New Security ID (SID).
   By default, the security ID is selected for Windows Vista systems and Longhorn sources and cannot be deselected.
4. To save your settings, select another option from the options list or click Next.

The identifiers of the destination virtual machine are assigned according to your settings.
Enter the Windows License Information

Ensure that you enter licensing information for all destination virtual machines running guest operating systems that are subject to licensing.

Prerequisites

On the Options page of the Export Virtual Machine wizard, click Advanced options, select Customize guest preferences for the virtual machine, and click Next to view and adjust the available customization options.

Procedure

1. On the Customizations page, select Windows license from the options list.
2. Enter Product ID information for the destination virtual machine.
3. (Optional) Select Include server license information if the guest operating system is Microsoft Windows Server 2003 or Microsoft Windows Server 2008.
4. Select a Server license mode option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Per seat</td>
<td>For individual user licenses.</td>
</tr>
<tr>
<td>Per server</td>
<td>For a concurrent user license. Specify the Maximum connections value when</td>
</tr>
<tr>
<td></td>
<td>you select this option.</td>
</tr>
</tbody>
</table>

5. To save your settings, select another option from the options list or click Next.

The Windows license information is saved to the destination virtual machine after the conversion.

Set the Time Zone

You can set the time zone if you are converting a virtual machine to use in a different time zone.

Prerequisites

On the Options page of the Export Virtual Machine wizard, click Advanced options, select Customize guest preferences for the virtual machine, and click Next to view and adjust the available customization options.

Procedure

1. On the Customizations page, select Time zone from the options list.
2. Select the target time zone from the Time zone drop-down menu.
3. To save your settings, select another option from the options list or click Next.

The time zone is set on the destination virtual machine after the conversion.

Configure the Network Adapters

You can configure the network settings of the virtual machine to work with the network configuration of the destination environment.

The option for configuring network adapters is available for all supported destinations.

Prerequisites

On the Options page of the Export Virtual Machine wizard, click Advanced options, select Customize guest preferences for the virtual machine, and click Next to view and adjust the available customization options.
**Procedure**

1. On the Customizations page, select **Network interface settings** from the options list.
2. Select a network adapter and click **Customize** to configure its properties.
   a. On the **General** tab, manually enter the IP address and DNS server address.
   b. On the **DNS** tab, specify the DNS connections by entering DNS suffixes.
   c. Enter a DNS suffix and click **Add**.
      You can add more than one DNS suffix.
   d. If you are entering multiple DNS suffixes, use **Move up** and **Move down** to specify the order in which the guest operating system uses the connections.
   e. On the **WINS** tab, type the primary and secondary WINS IP address in the text box.
3. To save your settings, select another option from the options list or click **Next**.

When powered on, the destination virtual machine uses the network settings that you configured.

**Assign a Workgroup or Domain Details**

You can set up the workgroup and the domain in which the destination virtual machine participates.

**Prerequisites**

On the Options page of the Export Virtual Machine wizard, click **Advanced options**, select **Customize guest preferences for the virtual machine**, and click **Next** to view and adjust the available customization options.

**Procedure**

1. On the Customizations page, select **Workgroup/Domain** from the options list.
2. Select how the virtual machine participates in the destination network.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Workgroup</strong></td>
<td>Valid characters include A-Z, a-z, 0-9, space, and the hyphen (-). Maximum length is 15 characters.</td>
</tr>
<tr>
<td><strong>Windows server domain</strong></td>
<td>The text box must have a value. Valid characters include A-Z, a-z, 0-9, space, period , and hyphen (-). Each label delineated by a period can be 63 characters. The entire text string can be up to 254 characters. User credentials are required.</td>
</tr>
</tbody>
</table>

3. To save your settings, select another option from the options list or click **Next**.

The destination virtual machine connects to the workgroup and domain server you specified.

**Install VMware Tools on the Destination Virtual Machine**

Install VMware Tools to improve graphics performance of the guest operating system. Other enhancements include automatic grab and release of the pointer between applications, copying and pasting between guest and host, improved mouse performance, and so on.

You can install VMware Tools to ESX, vCenter Server, Workstation 6.0 and 6.5, VMware Fusion 1.0 and 2.0, and VMware Player 2.0 and 2.5 destinations.
Procedure
1. On the Options page of the Export Virtual Machine wizard, select **Advanced options**.
2. Select the **Install VMware Tools on the destination virtual machine** check box.
3. To save your settings, select another option from the options list or click **Next**.

vCenter Converter installs VMware Tools on the destination machine during conversion.

**Remove System Restore Checkpoints**

When you export Windows XP or later source machines, VMware recommends that you remove all System Restore checkpoints to speed up the conversion process.

System Restore is enabled on Windows Vista and Windows XP systems by default. For Windows Vista, if you are performing volume-based file-level cloning, System Restore checkpoints are automatically removed from the destination virtual machine, regardless of whether the **Remove System Restore checkpoints on destination** check box is selected or deselected. If you are performing disk-based cloning or volume-based block-level cloning, deselecting the check box instructs vCenter Converter to keep the System Restore checkpoints in the destination virtual machine.

Removing all System Restore checkpoints prevents the target machine from reverting to a preconversion state. Restoring a checkpoint in the target virtual machine that was created before you cloned the source machine can damage the system and cause the target virtual machine to become unbootable.

**Procedure**
1. On the Options page of the Export Virtual Machine wizard, select **Advanced options**.
2. Select the **Remove System Restore checkpoints on destination** check box.
3. To save your settings, select another option from the options list or click **Next**.

**Update the Device Drivers on the Destination Virtual Machine**

You must reconfigure the destination virtual machine to allow it to start properly.

When exporting virtual machines, certain device drivers must be updated or disabled to allow the destination virtual machine to boot.

**Procedure**
1. On the Options page of the Export Virtual Machine wizard, select **Advanced options**.
2. Select the **Reconfigure destination virtual machine** check box.
3. To save your settings, select another option from the options list or click **Next**.

vCenter Converter updates the device drivers on the destination virtual machine so it can work with virtual hardware.
Configure the Export Task

You can configure the conversion process and select the behavior of the source and destination machine during and after conversion. You can change the status of the source and destination services only when the source machine is running a Windows operating system.

Set the Starting Mode of the Destination Services

To minimize downtime of a Windows service, you can select the service and have it start automatically on the destination virtual machine. You can also prevent Windows services from automatically starting on the destination machine.

You can set the destination services only for source machines that run Windows.

Procedure

1. On the Options page of the Export Virtual Machine wizard, select Services from the options list.
2. In the Startup mode column, select the starting mode for a service.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>The service starts automatically after the destination machine is powered on.</td>
</tr>
<tr>
<td>Manual</td>
<td>The service does not start after the destination machine is powered on, but you can start it manually.</td>
</tr>
<tr>
<td>Disabled</td>
<td>The service is disabled and does not start after the destination machine is powered on.</td>
</tr>
</tbody>
</table>

3. To save your settings, select another option from the options list or click Next.

Power On the Destination Virtual Machine After Conversion

You can power on the destination virtual machine after the conversion is complete.

You cannot power on hosted destination virtual machines.

Prerequisites

You must select a managed destination to power on the virtual machine immediately after the export task finishes.

Procedure

1. On the Options page, select Advanced options from the option list.
2. In the Post-conversion power state panel, select Power on target machine.
3. To save your settings, select another option from the options list or click Next.

After the conversion, vCenter Converter automatically powers on the destination machine.

Limit the Amount of Resources Used by the Export Task

A conversion task competes for computing resources with other processes. To limit the impact of the conversion task on other workloads, you can throttle it. If you do not modify task throttling, conversion tasks are carried out with normal priority and depending on the available computing resources during conversion.

A powered-on source machine runs its own conversion task. You can limit the impact of the conversion task on other workloads running on the powered-on machine.
For source machines different from powered-on machines, you can limit the resources used on the machine where vCenter Converter server is installed.

Throttling controls the CPU and network resources that the conversion process uses. You cannot throttle disk I/O from the vCenter Converter interface, but can throttle it indirectly by throttling the network.

Procedure

1. On the Options page of the Export Virtual Machine wizard, select Throttling from the options list.
2. From the CPU throttling drop-down menu, select the priority of the conversion task.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>The priority of the current conversion task is set to normal.</td>
</tr>
<tr>
<td>Light</td>
<td>The priority of the current conversion task is reduced slightly below normal.</td>
</tr>
<tr>
<td>Medium</td>
<td>The priority of the current conversion task is set to lowest.</td>
</tr>
</tbody>
</table>

**Note** vCenter Converter reduces the thread priorities of conversion tasks to control the CPU resources they consume.

3. Select Network bandwidth throttling to be able to select maximum network bandwidth.
4. In the network bandwidth spin-box, select the maximum network bandwidth at which vCenter Converter performs the conversion task.
5. To save your settings, select another option from the options list or click Next.

**Schedule the Export Task**

You can set the time at which you want an export task to start.

**Prerequisites**

You must start the Export Virtual Machine wizard as a scheduled task. For example, select File > New > Scheduled Task... and select Export a virtual machine from the drop-down menu.

**Procedure**

1. Complete the Export Virtual Machine wizard until you reach the Schedule Task page.
2. On the Schedule Task page, configure the scheduled task.
   - Make sure you give a detailed name and description to the task so that you can recognize it later among other scheduled tasks.
     a. In the Task name text box, type a name for the scheduled task.
     b. (Optional) In the Task description text box, type a description.
     c. From the Start date drop-down menu, select a date for the scheduled task.
     d. Use the Start time spin box to schedule the time at which the scheduled task starts.
3. Click Next to view a summary of the scheduled task.

After you complete the Export Virtual Machine wizard and submit the task, the export is scheduled for the specified time and is added to the vCenter Server list of scheduled tasks. If the scheduled time is the current time or a time in the past, the export task starts immediately.
Review the Summary and Submit the Export Task

On the Summary page, you can view a summary of the new conversion task before you add it to the task list. The summary includes information about the source machine, the destination virtual machine, destination customization settings (if any), and scheduled time (if any). vCenter Converter performs task validation at this stage.

Prerequisites

You must complete all task configuration steps to access the Summary page.

Procedure

1. Complete all the steps of the Export Virtual Machine wizard before you go to the Summary page.
   - If you selected to customize the Windows guest operating system, click **Next** on the Customizations page.
   - If you started the Export Virtual Machine wizard as a scheduled task, click **Next** on the Schedule task page.
   - If you did not select creation of a scheduled task or customize the Windows guest operating system, click **Next** on the Options page.

2. Review the summary of the task.

3. Click **Finish** to submit the task.

vCenter Converter validates the task parameters. This might take several minutes. If the task validation is successful, the task appears in the Recent Tasks list in vSphere Client. If the task validation fails, click **Back** and correct the invalid parameters.
You might need to reconfigure a virtual machine after you import or export it so that it is ready to start in the destination virtual environment. You might also need to reconfigure virtual machines if the virtual environment changed or if you need to improve their performance.

**Note** Only virtual machines that are running Windows XP or later can be reconfigured. You cannot reconfigure virtual machines that run operating systems other than Windows.

When you create a reconfiguration task, you can select which steps of the reconfiguration process to run.

- Install VMware Tools
- Customize the settings of a Windows guest operating system
- Remove System Restore checkpoints
- Reconfigure the virtual machine

**Prerequisites**

Power off the source machine that you want to reconfigure.

**Procedure**

1. **Save Sysprep Files** on page 78
   - To customize the guest operating system of a virtual machine that runs Windows Server 2003 or Windows XP, you must save the Sysprep files to the specified locations on the machine where vCenter Converter server runs.

2. **Start the Reconfigure Virtual Machine Wizard** on page 78
   - You use the vCenter Converter Reconfigure Virtual Machine wizard to select reconfiguration tasks for the selected virtual machine. You must complete the steps in the wizard to start a reconfiguration task.

3. **View Details About the Source Virtual Machine** on page 78
   - Before you continue with the reconfiguration process, you can view details about the virtual machine you selected to reconfigure.

4. **Select the Options to Reconfigure** on page 79
   - When you create a reconfiguration task, you can select which steps of the reconfiguration process to run.

5. **Review and Submit the Reconfiguration Task** on page 83
   - After you review your settings on the Summary page of the wizard, you can go back and change a setting or submit the task.
Save Sysprep Files

To customize the guest operating system of a virtual machine that runs Windows Server 2003 or Windows XP, you must save the Sysprep files to the specified locations on the machine where vCenter Converter server runs.

Prerequisites

You must download the Sysprep files that correspond to the operating system of the source machine.

Procedure

- Save the Sysprep files to the specified location for the Destination OS or Guest OS.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2003 (32 bit)</td>
<td>The Sysprep Files Location for Windows: %ALLUSERSPROFILE% \Application Data\VMware\VMware vCenter Converter\sysprep \svr2003</td>
</tr>
<tr>
<td>Windows Server 2003 (64 bit)</td>
<td>The Sysprep Files Location for Windows: %ALLUSERSPROFILE% \Application Data\VMware\VMware vCenter Converter\sysprep \svr2003-64</td>
</tr>
<tr>
<td>Windows XP (32 bit)</td>
<td>The Sysprep Files Location for Windows: %ALLUSERSPROFILE% \Application Data\VMware\VMware vCenter Converter\sysprep \xp</td>
</tr>
<tr>
<td>Windows XP (64 bit)</td>
<td>The Sysprep Files Location for Windows: %ALLUSERSPROFILE% \Application Data\VMware\VMware vCenter Converter\sysprep \xp-64</td>
</tr>
</tbody>
</table>

vCenter Converter can now customize Windows Server 2003 (32 bit and 64 bit) and Windows XP (32 bit and 64 bit) operating systems.

What to do next

You can now use the Reconfigure Virtual Machine wizard to customize Windows guest operating systems.

Start the Reconfigure Virtual Machine Wizard

You use the vCenter Converter Reconfigure Virtual Machine wizard to select reconfiguration tasks for the selected virtual machine. You must complete the steps in the wizard to start a reconfiguration task.

Procedure

- Right-click a powered-off virtual machine in any inventory or task view and select Reconfigure to start the Reconfigure Virtual Machine wizard.

What to do next

You are now ready to begin the customization process.

View Details About the Source Virtual Machine

Before you continue with the reconfiguration process, you can view details about the virtual machine you selected to reconfigure.

Procedure

1. On the Reconfigure VM page, click View source details to view details about the selected virtual machine.

   The Machine Details window appears, showing details about the guest operating system and the hardware configuration of the virtual machine.

2. Click Next to proceed with the reconfiguration.
Select the Options to Reconfigure

When you create a reconfiguration task, you can select which steps of the reconfiguration process to run.

Procedure

1. On the Options page, select one or more reconfiguration steps to perform.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install VMware Tools on the destination virtual machine</td>
<td>Installs VMware Tools to enhance the performance of the destination virtual machine.</td>
</tr>
<tr>
<td>Customize guest preferences for the virtual machine</td>
<td>Allows you to customize Windows XP or later guest operating systems so that the virtual machine is prepared to work immediately in the destination environment.</td>
</tr>
<tr>
<td>Remove System Restore checkpoints on destination</td>
<td>Removes System Restore checkpoints from the destination virtual machine.</td>
</tr>
<tr>
<td>Reconfigure destination virtual machine</td>
<td>Updates the drivers on the virtual machine so that it is bootable in a virtual environment.</td>
</tr>
</tbody>
</table>

2. Click Next.

What to do next

Depending on the reconfiguration options you selected, you can either customize the guest operating system or view the Summary page of the Reconfigure Virtual Machine wizard.

Install VMware Tools on a vCenter Server Virtual Machine

Install VMware Tools to improve graphics performance of the guest operating system. Other enhancements include automatic grab and release of the pointer between applications, copying and pasting between guest and host, improved mouse performance, and so on.

Install VMware Tools on the virtual machine you are reconfiguring.

Procedure

◆ On the Options page of the Reconfigure Virtual Machine wizard, select Install VMware Tools on the destination virtual machine and click Next.

vCenter Converter installs VMware Tools on the reconfigured virtual machine.

What to do next

Depending on the reconfiguration options you selected, you can either customize the guest operating system or view the Summary page of the Reconfigure Virtual Machine wizard.

Customize the Windows Guest Operating System

As a part of the reconfiguration task, you can customize guest operating systems running Windows XP or later.

Prerequisites

Save the Sysprep files to %ALLUSERSPROFILE%\Application Data\VMware\VMware vCenter Converter\sysprep on the machine that runs vCenter Converter server. For more details on the Sysprep files location for different operating systems, see “Save Sysprep Files,” on page 78.

On the Options page of the Reconfigure Virtual Machine wizard, select Customize guest preferences for the virtual machine and click Next to view and adjust the available customization options.
Customize the Identity of a Virtual Machine

To identify a virtual machine with the virtual network, personalize the virtual machine by editing its name, owner, and organization name, and by generating a new security ID.

Prerequisites

On the Options page of the Reconfigure Virtual Machine wizard, select Customize guest preferences for the virtual machine and click Next to view and adjust the available customization options.

Procedure

1. On the Customizations page, select Computer information from the options list.
2. Customize the guest operating system identity.
   a. In the Computer Name text box, specify a computer name to identify the virtual machine on the network. Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but vCenter Converter permits it. The computer name cannot contain more than 15 characters or consist only of numerals.
   b. In the Owner Name text box, write the name of the owner of the virtual machine. Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but vCenter Converter permits it. The owner name cannot have more than 63 characters or consist only of numerals.
   c. In the Organization field, enter an organization name. Valid characters include all printable characters. The limit is 63 characters.
3. (Optional) To create a new security identifier, select Generate New Security ID (SID).
   By default, the security ID is selected for Windows Vista systems and Longhorn sources and cannot be deselected.
4. To save your settings, select another option from the options list or click Next.

The identifiers of the reconfigured virtual machine are assigned according to your settings.

What to do next

Now you can select another option to set or click Next to view a summary of the reconfiguration task. If the Next button is inactive, check the Current settings list to the left for other settings that need your attention on this page.

Enter the Windows License Information

Ensure that you enter licensing information for all destination virtual machines running guest operating systems that are subject to licensing.

Prerequisites

On the Options page of the Reconfigure Virtual Machine wizard, select Customize guest preferences for the virtual machine and click Next to view and adjust the available customization options.

Procedure

1. On the Customizations page, select Windows license from the options list.
2. Enter Product ID information for the destination virtual machine.
3 (Optional) Select Include server license information if the guest operating system is Microsoft Windows Server 2003 or Microsoft Windows Server 2008.

4 Select a Server license mode option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Per seat</td>
<td>For individual user licenses.</td>
</tr>
<tr>
<td>Per server</td>
<td>For a concurrent user license. Specify the Maximum connections value when you select this option.</td>
</tr>
</tbody>
</table>

5 To save your settings, select another option from the options list or click Next.

The Windows license information is saved to the reconfiguration source machine when the reconfiguration task completes.

**What to do next**

Now you can select another option to set or click Next to view a summary of the reconfiguration task. If the Next button is inactive, check the Current settings list to the left for other settings that need your attention on this page.

**Set the Time Zone**

You can set the time zone if you are converting a virtual machine to use in a different time zone.

**Prerequisites**

On the Options page of the Reconfigure Virtual Machine wizard, select Customize guest preferences for the virtual machine and click Next to view and adjust the available customization options.

**Procedure**

1. On the Customizations page, select Time zone from the options list.
2. Select the target time zone from the Time zone drop-down menu.
3. To save your settings, select another option from the options list or click Next.

The time zone is set on the reconfiguration source machine when the reconfiguration task completes.

**What to do next**

Now you can select another option to set or click Next to view a summary of the reconfiguration task. If the Next button is inactive, check the Current settings list to the left for other settings that need your attention on this page.

**Configure the Network Adapters**

You can change the network settings of a virtual machine to work with the network configuration of the virtual environment.

The options for configuring network adapters are available for all supported customization sources.

**Prerequisites**

On the Options page of the Reconfigure Virtual Machine wizard, select Customize guest preferences for the virtual machine and click Next to view and adjust the available customization options.
Procedure

1. On the Customizations page, select **Network interface settings** from the options list.

2. Select a network adapter and click **Customize** to configure its properties.
   a. On the **General** tab, manually enter the IP address and DNS server address.
   b. On the **DNS** tab, specify the DNS connections by entering DNS suffixes.
   c. Enter a DNS suffix and click **Add**.
      You can add more than one DNS suffix.
   d. If you are entering multiple DNS suffixes, use **Move up** and **Move down** to specify the order in which the guest operating system uses the connections.
   e. On the **WINS** tab, type the primary and secondary WINS IP address in the text box.

3. To save your settings, select another option from the options list or click **Next**.

   When powered on, the reconfigured virtual machine uses the network settings that you specified.

**What to do next**

Now you can select another option to set or click **Next** to view a summary of the reconfiguration task. If the **Next** button is inactive, check the Current settings list to the left for other settings that need your attention on this page.

**Assign a Workgroup or Domain Details**

You can reconfigure the workgroup and the domain in which the virtual machine participates.

**Prerequisites**

On the Options page of the Reconfigure Virtual Machine wizard, select **Customize guest preferences for the virtual machine** and click **Next** to view and adjust the available customization options.

**Procedure**

1. On the Customizations page, select **Workgroup/Domain** from the options list.

2. Select how the virtual machine participates in the destination network.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Workgroup</strong></td>
<td>Valid characters include A-Z, a-z, 0-9, space, and the hyphen (-). Maximum length is 15 characters.</td>
</tr>
<tr>
<td><strong>Windows server domain</strong></td>
<td>The text box must have a value. Valid characters include A-Z, a-z, 0-9, space, period , and hyphen (-). Each label delineated by a period can be 63 characters. The entire text string can be up to 254 characters. User credentials are required.</td>
</tr>
</tbody>
</table>

3. To save your settings, select another option from the options list or click **Next**.

   The reconfigured virtual machine connects to the workgroup and domain server you specified.

**What to do next**

Now you can select another option to set or click **Next** to view a summary of the reconfiguration task. If the **Next** button is inactive, check the Current settings list to the left for other settings that need your attention on this page.
Remove System Restore Checkpoints

Remove the System Restore checkpoints of newly imported source machines to prevent them from reverting to a preconversion state. For other reconfiguration source machines, removing System Restore checkpoints helps you save disk space by deleting unnecessary data.

Procedure

◆ On the Options page of the Reconfigure Virtual Machine wizard, select Remove System Restore checkpoints on the destination and click Next.

The System Restore checkpoints are deleted from the reconfiguration source machine.

What to do next

Depending on the reconfiguration options you selected, you can either customize the guest operating system or view the Summary page of the Reconfigure Virtual Machine wizard.

Update the Device Drivers

If a newly imported virtual machine does not start properly in the destination virtual environment, try reconfiguring it to update its device drivers.

Procedure

◆ On the Options page of the Reconfigure Virtual Machine wizard, select Reconfigure destination virtual machine and click Next.

vCenter Converter updates the device drivers on the reconfiguration source so it can work in the virtual environment.

What to do next

Depending on the reconfiguration options you selected, you can either customize the guest operating system or view the Summary page of the Reconfigure Virtual Machine wizard.

Review and Submit the Reconfiguration Task

After you review your settings on the Summary page of the wizard, you can go back and change a setting or submit the task.

Procedure

1 Review the summary of the settings for the destination virtual machine.
2 Click Finish to submit the reconfiguration task.

The task appears in the Recent Tasks list as well as on the Tasks & Events tab. You can view the progress on the Task Progress tab.

What to do next

To view details about the reconfiguration task you can right-click the task and select View Summary.
Managing vCenter Converter Tasks

You can manage vCenter Converter tasks in the same way you manage all vSphere Client tasks. After you submit a task, it appears in the Recent Tasks list. You can monitor, copy, or cancel a running import, export, or reconfiguration task. If you scheduled an import or export task, you can run it immediately, reschedule it, reconfigure it, or delete it from the Scheduled Tasks list.

For general information about task management, see the vSphere Datacenter Administration Guide.

This chapter includes the following topics:

- “Displaying and Monitoring vCenter Converter Tasks,” on page 85
- “Managing Scheduled Import and Export Tasks,” on page 87
- “Collecting vCenter Converter Log Files,” on page 89

Displaying and Monitoring vCenter Converter Tasks

vSphere Client provides several ways to monitor running, completed, or scheduled vCenter Converter tasks.

- The Tasks view on the Tasks & Events tab displays a list of current and completed tasks for a selected inventory object.
- The Recent Tasks panel displays a list of current and recently completed tasks for all inventory objects.
- The Scheduled Tasks view displays a list of scheduled tasks for all inventory objects.
- Monitor the Status of a Task for an Inventory Object on page 86
  You can use vCenter Converter to monitor the status of conversion tasks in vSphere Client. You can check whether a task is queued, in progress, successfully completed, or failed.
- Display Completed or Current Conversion Tasks on page 86
  You can monitor recently completed or current tasks for all inventory objects.
- View Task Details on page 86
  You can view detailed information about specific tasks in the Task Details pane or the Task Summary dialog box.
- Copy an Existing Conversion Task on page 87
  You can create a new task by copying a conversion task, including scheduled tasks, regardless of the task status. Copying a task allows you to reuse and modify information from the original one without having to reenter it into the wizard.
- Cancel a Task on page 87
  You can cancel a task that is in the queue or in progress. Canceled tasks are labeled as failed, with a message indicating that a user canceled the task.
Monitor the Status of a Task for an Inventory Object

You can use vCenter Converter to monitor the status of conversion tasks in vSphere Client. You can check whether a task is queued, in progress, successfully completed, or failed.

Prerequisites

You must create an import, export, or reconfiguration task to view it in the task list.

Procedure

1. Start vSphere Client and connect to the vCenter Server associated with vCenter Converter.
2. Click Inventory in the navigation bar and select the Hosts & Clusters view.
3. Select an inventory object (for example, a host) and click the Tasks & Events tab.
4. Click Tasks.

The task status is indicated by corresponding icons, listed in Table 7-1.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>Task completed successfully.</td>
</tr>
<tr>
<td>✗</td>
<td>Task failed. Review the task details for more information.</td>
</tr>
<tr>
<td>💡</td>
<td>Task is queued or in progress. Tasks are queued when system resources are heavily loaded. Queued tasks run when adequate system resources become available. Tasks that are in progress include a status bar that displays the progress.</td>
</tr>
</tbody>
</table>

Display Completed or Current Conversion Tasks

You can monitor recently completed or current tasks for all inventory objects.

Procedure

1. Start vSphere Client and connect to the vCenter Server associated with vCenter Converter.
2. If the Recent Tasks panel is not displayed, click Tasks in the status bar.

The Recent Tasks panel displays information about recently completed or current import, export, or reconfiguration tasks.

View Task Details

You can view detailed information about specific tasks in the Task Details pane or the Task Summary dialog box.

The Task Details pane displays information about the task and related events. When a task fails, this pane includes information about the location of log files that might help troubleshoot the issue. Log files are temporary, so access them as soon as possible after a failure.

Prerequisites

Before viewing details of a conversion task, verify that it is in progress.
Procedure

- In the Recent Tasks panel, right-click a task and select **View Summary**.

  The Task Summary window opens.

**What to do next**

You can see information about the source and destination system from the **Summary** tab. You can view information about the task status from the **Task progress** tab.

**Copy an Existing Conversion Task**

You can create a new task by copying a conversion task, including scheduled tasks, regardless of the task status. Copying a task allows you to reuse and modify information from the original one without having to reenter it into the wizard.

**Procedure**

- To copy a running or a cancelled task, right-click a task and select **Copy As New** in the Recent Tasks panel.
- To copy a non-running scheduled import or export task, right-click a task and select **Copy As New** in the Scheduled Tasks list.

  The wizard associated with the original task starts (for example, if the original task is an export task, the Export Virtual Machine wizard starts).

**What to do next**

Modify the import or export settings in the relevant wizard and submit the task.

**Cancel a Task**

You can cancel a task that is in the queue or in progress. Canceled tasks are labeled as failed, with a message indicating that a user canceled the task.

**Procedure**

1. On the **Tasks & Events** tab, right-click the task and select **Cancel**.
2. Click **Yes** in the confirmation dialog box to cancel the task.

  The task is canceled and appears as failed in the Recent Tasks list.

**Managing Scheduled Import and Export Tasks**

You can copy, delete, reconfigure, and reschedule scheduled import and export tasks. You can also cancel scheduled tasks that are running:

- **Run a Scheduled Import or Export Task Immediately** on page 88
  
  Scheduled tasks are configured to run at a specified date and time. However, you can choose to run a scheduled task immediately. Running a scheduled task immediately removes it from the list of Scheduled Tasks.

- **Monitor Scheduled Import and Export Tasks** on page 88
  
  You can check which import and export tasks are scheduled and when each task last ran.

- **Edit a Scheduled Import or Export Task** on page 88
  
  If you want to change the time at which an import or export task begins, you can reschedule it.
**Duplicate a Scheduled Import or Export Task** on page 89
You can change the source machine or the destination type, change the hardware and software settings of the destination virtual machine, and schedule a new time by making a new copy of a scheduled task.

**Delete a Scheduled Import or Export Task** on page 89
You can remove a scheduled import or export task from the vCenter Server list of scheduled tasks.

### Run a Scheduled Import or Export Task Immediately

Scheduled tasks are configured to run at a specified date and time. However, you can choose to run a scheduled task immediately. Running a scheduled task immediately removes it from the list of Scheduled Tasks.

**Prerequisites**
You must have at least one import or export task scheduled to run it immediately.

**Procedure**
1. In vSphere Client, select **View > Management > Scheduled Tasks**.
2. Right-click a task and select **Run**.

The task is run immediately, or is queued until resources are available for running it. The task is also removed from the list of scheduled tasks.

**What to do next**
Modify the import or export settings in the relevant wizard and submit the task.

### Monitor Scheduled Import and Export Tasks

You can check which import and export tasks are scheduled and when each task last ran.

**Prerequisites**
Make sure you give all your import and export tasks a detailed task name and description to recognize them among other scheduled tasks.

**Procedure**
1. Start vSphere Client and connect to the vCenter Server associated with vCenter Converter.
2. Click **Scheduled Tasks** in the upper-right corner of the navigation bar to determine which tasks are scheduled and when each task last ran.

A detailed list of all scheduled tasks appears.

**What to do next**
You can monitor the status of all import and export tasks in the Scheduled Tasks list.

### Edit a Scheduled Import or Export Task

If you want to change the time at which an import or export task begins, you can reschedule it.

**Prerequisites**
The list of scheduled tasks for vCenter Server must contain at least one import or export task.
Procedure
1 In vSphere Client, select View > Management > Scheduled Tasks.
2 From the list, right-click a scheduled import or export task and select Properties.
   The Schedule Task wizard opens.
3 On the Schedule task page, assign a new time for the import or export task and click Next.
4 On the Summary page, click Finish.
   The rescheduled time appears in the Next run column.

Duplicate a Scheduled Import or Export Task
You can change the source machine or the destination type, change the hardware and software settings of the destination virtual machine, and schedule a new time by making a new copy of a scheduled task.

Prerequisites
The list of scheduled tasks for vCenter Server must contain at least one import or export task.

Procedure
1 In vSphere Client, select View > Management > Scheduled Tasks.
2 From the list, right-click a scheduled import or export task and select Copy As New.
3 Configure the new scheduled task by completing the wizard.
   An empty virtual machine is created after you click Finish. The actual conversion begins at the scheduled time.

Delete a Scheduled Import or Export Task
You can remove a scheduled import or export task from the vCenter Server list of scheduled tasks.
You can remove only scheduled import or export tasks that vCenter Server has not run yet.

Prerequisites
The list of scheduled tasks for vCenter Server must contain at least one import or export task.

Procedure
1 In vSphere Client, select View > Management > Scheduled Tasks.
2 From the list, right-click a task and select Remove.
3 In the confirmation dialog box, click Yes.
   The selected task is deleted from the list. The empty virtual machine that vCenter Converter creates when you submit a new scheduled is also deleted.

Collecting vCenter Converter Log Files
The vCenter Converter log files contain information about activities in your vCenter Converter environment. VMware technical support might request these files to help you resolve any problems that might occur when you use vCenter Converter.

For information about collecting log information for other components in the vSphere environment, see the vSphere 4.1 documentation.
You can export vCenter Converter logs in several ways.
Export the Recent vCenter Converter Log Files on page 90
If you cannot complete the vCenter Converter wizard due to a query or verification error, you can retrieve diagnostic information for the last performed actions in the wizard.

Export the Log Files for a Task on page 90
You can export the log files for a past conversion or reconfiguration task by using the pop-up menu that opens when you right-click a task in the vSphere Client tasks list.

Export All vCenter Converter Log Files on page 91
You can retrieve all available log files of the vCenter Converter server machine by using the Administration menu of the vSphere Client.

Export the Recent vCenter Converter Log Files
If you cannot complete the vCenter Converter wizard due to a query or verification error, you can retrieve diagnostic information for the last performed actions in the wizard.

Procedure
1. In the vCenter Converter wizard, click **Export diagnostics logs...** next to the Help button.
   An Export To window opens and prompts you to save the log files as a .zip archive.
2. (Optional) Browse to the location where you want to save the .zip archive.
   By default, the log files are saved in the current user profile on the system where the vCenter Converter client runs.
3. Name the .zip archive and click **Save**.
   The log information is saved as a .zip archive in the selected location.

What to do next
You can now extract the log files from the archive or send the .zip archive to VMware technical support.

Export the Log Files for a Task
You can export the log files for a past conversion or reconfiguration task by using the pop-up menu that opens when you right-click a task in the vSphere Client tasks list.

Procedure
1. In the Recent Tasks list of vSphere Client, right-click a completed conversion or reconfiguration task and select **Export Logs...**.
   An Export To window opens and prompts you to save the log files as a .zip archive.
2. (Optional) Browse to the location where you want to save the .zip archive.
   By default, the log files are saved in the current user profile on the system where the vCenter Converter client runs.
3. Name the .zip archive and click **Save**.
   The log information is saved as a .zip archive in the selected location.

What to do next
You can now extract the log files from the archive or send the .zip archive to VMware technical support.
Export All vCenter Converter Log Files

You can retrieve all available log files of the vCenter Converter server machine by using the Administration menu of the vSphere Client.

Procedure

1. From the Administration menu of a vSphere Client select Export vCenter Converter Logs...
   An Export To window opens and prompts you to save the log files as a .zip archive.

2. (Optional) Browse to the location where you want to save the .zip archive.
   By default, the log files are saved in the current user profile on the system where the vCenter Converter client runs.

3. Name the .zip archive and click Save.
   The log information is saved as a .zip archive in the selected location.

What to do next

You can now extract the log files from the archive or send the .zip archive to VMware technical support.
Index

A

Acronis True Image, source 21
add a disk 43, 44, 64
add a virtual disk 65
advanced customization
  guest operating system 49, 70, 79
  installing VMware Tools 52
  reconfiguring destination 53
  removing system restore checkpoints 52, 83
  synchronizing source and destination 55
  updating drivers 53
agent 8
allocate memory 47, 69
audience 5

C
cancelling tasks 87
cloning
  cold, defined 9
  defined 9
  disk based 14
  disk-based cloning 15
  hot cloning 11
  hot, defined 9
  volume based 14
  volume-based cloning 14
cloning modes 14
cloning scheduled tasks 89
clusters, specifying for destination 61
cold cloning
  boot CD 14
  defined 9
  example flow 14
collecting logs
  all tasks 91
  complete tasks 90
recent task 90
completing reconfiguration setup 83
components, vCenter Converter 8
configure the hardware
  allocate memory 47, 69
  configure the Helper VM network 48
  configure the network settings 48, 69
  edit the number of processors 46, 68
  specify a disk controller 47, 69
configure the hardware of the destination machine 41, 63
configure the import task 53
configure the network settings 48, 69
configure the software 48, 69
configuring
  sysprep files locations 28
  Sysprep files locations 78
  view summary 57, 76
configuring export 74
configuring permissions for vCenter users 24
conversion limitations
  Linux guest limitations 22
  powered-on machine limitations 22
  reconfiguration limitations 22
  third-party images limitations 22
  third-party virtual machines or system images 23
  virtual machines 22
  VSS snapshots 28
  windows guest limitations 22
conversion tasks
cancelling 87
copying 87
displaying 86
managing 85
monitoring 85, 86
viewing details 86
converting
  existing system images 15
  existing virtual machines 15
  converting, powered-on machines 55
copy all disks 46, 68
copy disks or volumes
  add a virtual disk 65
  copy all disks 46, 68
create an expandable disk on a hosted destination 66
create an expandable disk on a managed destination 45, 66
delete a disk 46, 67
delete a volume 43, 64
move a disk to a different datastore 45
move a volume to a different datastore 44
move a volume to a different virtual disk 43, 64
resize a volume 43, 63
split a disk into 2GB files 67
copy source machine changes to destination 11
copying conversion tasks 87
copying scheduled tasks 89
create an expandable disk on a hosted destination 66
create an expandable disk on a managed destination 45, 66
customization 28
customize the location 40
customizing
  computing resources 55, 74
  export throttling 74
  import throttling 55
customizing the guest operating system 49, 70, 79

datastores 61
delete a disk 46, 67
delete a volume 43, 64
deleting scheduled tasks 89
destination
  ESX host 23
  vCenter Server 23
  VirtualCenter 23
  VMware Fusion 23
  VMware Player 23
  VMware Server 23
  Workstation 23
destination machines, power on 55, 74
destination services
  starting mode 54
  stop 54
destination setup
  computer information 49, 70, 80
  DNS 51, 71, 81
domain details 51, 72, 82
guest operating system customization
  computer information 49, 70, 79
  network adapters 51, 71, 81
  SID 49, 70, 80
  time zone 51, 71
  Windows license 50, 71, 80
  WINS 51, 71, 81
  workgroup 51, 72, 82
disk cloning modes
  disk-based cloning, defined 15
  volume-based cloning, defined 14
disk controller 47, 69
disk volume 43, 44, 64
disk volumes 43, 63, 64
disk-based cloning 14, 15, 42, 45, 46, 63, 66, 68
disks
  adding 44
  thin-provisioned 45, 66
displaying tasks 86
dual boot systems 9
duplicate ID 16
E
edit the number of processors 46, 68
ingesting scheduled tasks 88
errors, viewing in the log files 90
ESX host
  destination 23
  source 21
  support 21
ESX VM, source 38
export tasks
  configuring 74
  scheduling 75
  submitting 76
  viewing task summary 76
export throttling 74
export wizard 60
exporting
  configure the hardware 63
  select a virtual machine folder 62
to hosted formats 59, 61, 62
to managed formats 59, 61, 62
exporting a single task log file 90
exporting machines
  destination services 74
  moving disks 65
  updating drivers 73
F
feedback 5
folder, location of application 31
G
guest operating system customization
  computer information 49, 70, 79
  DNS 51, 71, 81
  network adapters 51, 71, 81
  SID 49, 70, 80
  time zone 51, 71
  Windows license 50, 71, 80
  WINS 51, 71, 81
  workgroup and domain page 51, 72, 82
guest operating system, customization 49, 70, 79
guest operating system, customizing 49, 70, 79
GUID Partition Table (GPT) disks 14
H
Helper VM 48
hosted destinations exporting to 62
Fusion 62
VMware Server 62
Workstation 62
hosted VM, source 38
hot cloning defined 9
Linux sources 13
Windows sources 11
HTTPS port 31
Hyper-V Server VM, source 39
Hyper-V, source 21
I
import machine wizard 35
import task scheduling 56
submitting 57
viewing task summary 57
import throttling 55
importing machines
configure the destination location 40
configure the hardware 41
customize the location 40
select a source machine 36
select a virtual machine folder 41
install VMware Tools 52, 72, 79
installation 31
installation space requirements 20
installing, VMware vCenter Converter Client 32
introduction 7
Inventory view
Hosts & Clusters 60
Virtual Machines & Templates 60
IPng support 24
IPV6 support 24
L
live cloning, See hot cloning
locating log information 89
log files, exporting and viewing 90
log information, locating 89
M
managing scheduled tasks 87
managing tasks 85
Master Boot Record (MBR) disks 14
Microsoft Virtual PC, source 21
Microsoft Virtual Server, source 21
modes of cloning 14
monitoring scheduled tasks 88
monitoring tasks 85, 86
move a disk to a different datastore 45
move a volume to a different datastore 44, 64
move a volume to a different virtual disk 43, 64
N
network settings 48, 69
not pre-allocated disks 66
O
offline cloning, See cold cloning
online cloning, See hot cloning
operating systems, support 19
P
Parallels Desktop, source 21
permissions, configuring for vCenter users 24
port requirements 25
power off source machine 55
power on destination machine 55
powered-on machine conversion limitations 22
powered-on machine, source 36, 37
R
reconfiguration completing tasks 83
time zone 81
reconfiguration options 79
reconfigure wizard 78
reconfiguring machines
time zone 81
update drivers 83
resources, specifying 61
running scheduled tasks 88
S
scheduled tasks
cloning 89
copying 89
deleting 89
editing 88
managing 87
monitoring 88
starting manually 88
scheduling, conversion tasks 16
scheduling import tasks 56
select a virtual machine folder 41, 62
selecting sources
ESX virtual machine 38
hosted virtual machine 38
Hyper-V Server VM 39
Linux powered-on machine 37
powered-on machine 36
third-party VM 39
vCenter Server VM 38
Windows powered-on machine 36
setting up destination
computer information 49, 70, 80
DNS 51, 71, 81
domain details 51, 72, 82
guest operating system 49, 70, 79
network adapters 51, 71, 81
SID 49, 70, 80
time zone 51, 71
Windows license 50, 71, 80
WINS 51, 71, 81
workgroup 51, 72, 82
Simple File Sharing, turning off 27
snapshots, limitations 28
source machine
power off 55
uninstall vCenter Converter agent 56
specify a disk controller 47, 69
split a disk into 2GB files 67
starting the wizard
export 60
for reconfigure 78
stop destination services 54
StorageCraft ShadowProtect, source 21
support 5
supported destination types
ESX host 23
vCenter Server 23
virtual appliances 23
VirtualCenter 23
VMware Fusion 23
VMware Player 23
VMware Server 23
Workstation 23
supported operating systems 19
supported source types
Acronis True Image 21
ESX support 21
Hyper-V 21
Microsoft Virtual PC support 21
Microsoft Virtual Server support 21
Parallels Desktop 21
powered-on machines 21
StorageCraft ShadowProtect 21
Symantec LiveState Recovery 21
vCenter Server 21
Virtual Iron 21
VirtualCenter support 21
VMware Fusion support 21
VMware Server support 21
VMware virtual machines 21
Workstation support 21
Xen 21
Symantec LiveState Recovery, source 21
synchronizing source with destination 55
sysprep 28
system images, converting existing 15
system reconfiguration 9
system requirements
installation space requirements 20
TCP/IP and UDP port requirements 25
Windows operating systems 26
system restore checkpoints 52, 73

T
table of contents pane 60
tasks, scheduling 16
TCP/IP and UDP port requirements 25
thin-provisioned destination disks 8
thin-provisioned disk 45, 66
third-party VM, source 39
throttling export tasks 74
throttling import tasks 55

U
uninstall vCenter Converter agent 56
uninstalling, vCenter Converter client 34
updating device drivers 53

V
vCenter Converter
agent 8
client 8
components 8
migration with 8
server 8
tasks 8
uninstalling components 33
worker 8
vCenter Converter client
disabling 33
enabling 33
uninstalling 34
vCenter permissions 24
vCenter Server 21
vCenter Server support 21
vCenter Server VM, source 38
vCenter Server, destination 23
version support 21
viewing conversion task summary 57
viewing export task summary 76
viewing source details 78
viewing tasks details 86
viewing the log files 90
virtual disk 43, 44, 64
virtual disk, add 44
virtual hardware
  CPU issues 16
  disk device issues 16
  Ethernet adapter issues 16
  graphics card issues 16
Virtual Iron, source 21
virtual machines
  conversion limitations 22
  converting existing 15
  destination on same network as source 15
VirtualCenter
  destination 23
  source 21
  support 21
VMware Fusion
  destination 23
  source 21
  support 21
VMware hosted products support 21
VMware managed products support 21
VMware Player
  destination 23
  source 21
  support 21
VMware Server
  destination 23
  source 21
  support 21
VMware Tools 52, 72, 79
VMware vCenter Converter, default location of application folder 31
VMware vCenter Converter Boot CD 8
VMware vCenter Converter Client, installing 32
volume-based cloning 14, 42–46, 63, 64, 66, 67
volume-based cloning, defined 14
volume, supported types 14
volumes, copy 44
VSS snapshots limitations 28
W
Windows, Simple File Sharing 27
Windows virtual machines, reconfiguring 77
Windows XP, turning off Simple File Sharing 27
Windows XP, checking Windows Firewall blocks 27
wizard, export 60
wizard table of contents pane 60
worker 8
Workstation
  destination 23
  source 21
  support 21
X
Xen, source 21